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1	 ขอมูลความปลอดภัยที่สำคัญ

การบำรุงรักษาทั่วไป

การแปลเอกสารน ี ้ ใช เพ ื ่อการอ างอ งิเท าน ั ้ น 

หากฉบ บัภาษาองักฤษและฉบ บัแปลไม สอดคล องก นั ฉบ บัภาษาองักฤษ 

เป นฉบ บัท ี ่ม ีผลบงัค บัใช เหน ือกว า

 

ขอควรระวัง

ในการหล ีกเล ี ่ยงความเส ียหายและการทำงานผ ิดปกต ิ:••
อย าให เคร ื ่องเล นถ กูความร อนส งูมากเก ินไป ซ ึ ่งเก ิดจากอปุกรณทำความร อน••
หร ือแสงแดดโดยตรง
ห ามทำเคร ื ่องเล นตก หร ือห ามทำให ว ตัถใุดๆ ตกลงบนเคร ื ่องเล นของคณุ••
ห ามทำเคร ื ่องเล นตกน  ห ามม ิให ช องเส ียบห ฟู ง หร ือช องใส แบตเตอร ี ่ถ กูน เ••
น ื ่องจากน ท ี ่เข าไปในต วัเคร ื ่องอาจทำให ต วัเคร ื ่องได ร บัความเส ียหายรนุแรง
อาจม ีสญัญาณรบกวนหากม โีทรศ พัท ม ือถ ือท ี ใ่ช งานในบร ิเวณใกล เค ียง ••
สำรองไฟล ของคณุ ตรวจสอบว าคณุเก บ็ไฟล ต นฉบ บัท ี ่คณุดาวน โหลดลงในอปุ••
กรณของคณุ Philips จะไม ร บัผ ิดชอบต อความเส ียหายใดท ี ่เก ิดข ึ ้ นก บัข อม ลู 
หากผล ิตภณัฑ ได ร บัความเส ียหาย หร ือไม สามารถอ านข อม ลูได  
จ ดัการ (ถ ายโอน, ลบ, อ ื ่นๆ) ไฟล เพลงของคณุด วยซอฟต แวร เพลงท ี ใ่ห มาเท า••
น ั ้ นเพ ื ่อหล ีกเล ี ่ยงป ญหาต างๆ 
ห ามใช สารทำความสะอาดท ี ่ม ีส วนผสมของแอลกอฮอล  แอมโมเน ีย เบนซ ิน ••
หร ือ สารท ี ่ม ฤีทธ ิ ์ ก ดักร อน เน ื ่องจากสารเหล าน ี ้ จะทำให เคร ื ่องเล นชำร ุ
ดเส ียหาย

 

เก ี ย่วกบัการทำงานและอณุหภ มู ิการจดัเก บ็

ใช งานในท ี ่ท ี ่ม ีอณุหภ ูม ิระหว าง 0 และ 35ºC (32 ถ งึ 95ºF) เสมอ•	
จ ดัเก บ็ในท ี ่ท ี ่ม ีอณุหภ ูม ิระหว าง -20 และ 45ºC (-4 to 113ºF) •	
เสมอ

อายกุารใช งานแบตเตอร ี ่อาจส ั ้ นลงในสภาพอณุหภ ูม ิต •	
 

ช ิ ้ นส วน/อปุกรณ เสร ิม:

โปรดไปท ี ่ www.philips.com/support เพ ื ่อส ั ่งซ ื ้ อช ิ ้ นส วน/

อปุกรณเสร ิม

 

การฟงอยางปลอดภัย

ฟงที่ระดับเสียงปานกลาง:

การใชหูฟงในระดับเสียงที่ดังมากอาจเปนอันตรายตอการไดยินของคุณ ผลิตภัณ

ฑนี้สามารถใหเสียงในชวงระดับความดังที่อาจกอใหเกิดการสูญเสียการไดยินสำห

รับบุคคลปกติ แมวาจะฟงในระยะเวลาไมถึงนาที ชวงระดับความดังเสียงที่ดังขึ้น

มีไวสำหรับผซึ่งอาจประสบกับการสูญเสียการไดยินอยแลว

เสียงอาจจะผิดเพี้ยนได ในชวงระยะเวลาหนึ่งการปรับการไดยินเสียง 

“ในระดับที่ฟงสบาย” จะเปนระดับเสียงที่ดังขึ้น ดังนั้น หลังการฟงเปนเวลานาน 

เสียง “ปกติ” แทจริงแลวอาจเปนเสียงดัง และเปนอันตรายตอการไดยินเสียงของคุ

ณ เพื่อปองกันมิใหเกิดเหตุการณนี้ ใหคุณตั้งคาระดับเสียงในระดับที่ปลอดภัยกอ

นที่จะปรับการไดยินเสียง และปลอยไว

ในการตั้งคาระดับเสียงในระดับที่ปลอดภัย:

ใหปรับการควบคุมเสียงไปที่การตั้งคาต

ใหเพิ่มระดับเสียงอยางชาๆ จนกระทั่งคุณสามารถไดยินเสียงชัดเจนและรสึกสบา

ย โดยไมมีความผิดเพี้ยน

ฟงเปนชวงระยะเวลาที่เหมาะสม:

การฟงเปนระยะเวลานาน แมในระดับเสียง ‘ปลอดภัย’ สามารถกอใหเกิดการสู

ญเสียการไดยิน

ตรวจสอบใหแนใจวาใชงานอุปกรณอยางพอเหมาะและหยุดพักอยางเหมาะสม

ตรวจสอบใหแนใจวาไดทำตามคำแนะนำตอไปนี้เมื่อใชงานหูฟงของคุณ

ฟงที่ระดับเสียงพอดีและเปนระยะเวลาที่เหมาะสม

ระมัดระวังไมปรับระดับเสียงเนื่องจากการปรับการไดยินเสียงของคุณ

หามเปดเสียงดังมากเกินไปเนื่องจากคุณจะไมสามารถไดยินเสียงรอบตัวคุณ

คุณควรใชอยางระมัดระวังหรือหยุดการใชงานชั่วคราวในสถานการณที่มีแนว 

โนมวาจะเปนอันตราย

หามใชหูฟงขณะควบคุมยานพาหนะ ป่นจักรยาน เลนสเก็ตบอรด และอื่นๆ เนื่อง

จากอาจเปนอันตรายตอการจราจรและผิดกฎหมายในหลายพื้นที่ 

 

การดัดแปลง

การดัดแปลงใด ๆ โดยไมไดรับอนุญาตจากผผลิตอาจสงผลใหสิทธิ์การใชงานอุป

กรณของผใชเปนโมฆะ

 

ขอมูลลิขสิทธิ์

ชื่อผลิตภัณฑและยี่หออื่นๆ ทั้งหมดเปนเครื่องหมายการคาของบริษัทหรือองค

กรรายนั้นๆ

การทำสำเนาสิ่งที่บันทึกใดๆโดยไมไดรับอนุญาต ไมวาจะเปนการดาวนโหลดจ

ากอินเตอรเน็ตหรือจากซีดีเพลงถือเปนการละเมิดกฏหมายลิขสิทธิ์และสนธิสัญ

ญาระหวางประเทศ

การทำสำเนาสื่อที่มีการปองกันการทำสำเนา รวมถึงโปรแกรมคอมพิวเตอร ไฟล 

การกระจายเสียง และการบันทึกเสียงโดยไมไดรับอนุญาตอาจเปนการละเมิดลิ

ขสิทธิ์ และถือวาเปนการกระทำผิดทางอาญา ไมควรนำอุปกรณนี้ไปใชเพื่อจุด

ประสงคดังกลาว

Windows Media และโลโก Windows เปนเครื่องหมายการคาจดทะเบียนของ 

Microsoft Corporation ในสหรัฐอเมริกาและ/หรือประเทศอื่นๆ

 

มีความรับผิดชอบ! เคารพลิขสิทธิ์

Philips เคารพตอทรัพยสินทางปญญาของผอื่น และเราขอใหผใชของเรากระท

ำเชนนั้นดวย 

ขอมูลมัลติมีเดียบนอินเตอรเน็ตอาจมีการสรางขึ้น และ/หรือเผยแพรโดยไมไดรับ

อนุญาตจากเจาของลิขสิทธิ์เดิม 
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การคัดลอก หรือการเผยแพรขอมูลที่ไมไดรับอนุญาตอาจเปนการละเมิดกฎหมาย

ลิขสิทธิ์ในหลาย ๆ ประเทศ รวมทั้งประเทศของคุณ 

การปฏิบัติตามกฎหมายลิขสิทธิ์นั้นจึงอยในความรับผิดชอบของคุณ

การบันทึก และการถายโอนไปยังเครื่องเลนแบบพกพาของการสตรีมวิดีโอซึ่งดาว

นโหลดไวในเครื่องคอมพิวเตอรของคุณนั้นมีจุดประสงคเพื่อใชกับโดเมนสาธารณ

ะหรือขอมูลที่ไดรับลิขสิทธิ์ถูกตองเทานั้น คุณอาจใชขอมูลนั้นสำหรับการ 

ใชสวนตัวซึ่งไมใชเชิงพาณิชย และตองเคารพคำแนะนำในการใชลิขสิทธิ์ซึ่งกำห

นดโดยเจาของลิขสิทธิ์ของงานนั้นในที่สุด คำแนะนำนั้นอาจระบุวาหามมิใหมีการ

คัดลอกเพิ่มเติม การสตรีมวิดีโออาจมีเทคโนโลยีปองกันการคัดลอกซึ่งไมอนุญาตใ

หทำการคัดลอกเพิ่มเติม ในสถานการณเชนนั้น ฟงกชันการบันทึกจะไมทำงาน แ

ละคุณจะไดรับขอความแจงใหทราบ

 

การบันทึกขอมูล

Philips มงมั่นที่จะพัฒนาคุณภาพผลิตภัณฑของคุณ และเสริมประสบการณผใช 

Philips ใหนาประทับใจยิ่งขึ้น เพื่อใหทราบถึงลักษณะการใชงานอุปกรณ

นี้ เครื่องเลนนี้จะบันทึกขาวสาร / ขอมูลลักษณะการใชงานไวในสวนขอ

งหนวยความจำแบบไมลบเลือนของเครื่อง ขอมูลเหลานี้นำไปใชเพื่อระบุ 

และคนหาขอผิดพลาด หรือปญหาตาง ๆ ที่คุณในฐานะที่เปนผใชอาจประ

สบขณะใชอุปกรณ ขอมูลที่จัดเก็บ ไดแก ระยะเวลาการเลนในโหมดเพลง 

ระยะเวลาการเลนในโหมดวิทยุ จำนวนครั้งที่แบตเตอรี่ใกลจะหมด ฯลฯ ขอมูลที่จั

ดเก็บจะไมแสดงใหเห็นถึงเนื้อหา หรือสื่อที่ใชบนอุปกรณ หรือแหลงที่ดาวนโหลด 

ขอมูลที่จัดเก็บบนอุปกรณสามารถเรียกดู และนำมาใช เฉพาะเมื่อผใชส

งอุปกรณคืนแกศูนยบริการ Philips เทานั้น และเพื่อใหงายตอการคนหา 

และปองกันขอผิดพลาดเทานั้น ผใชสามารถใชขอมูลที่จัดเก็บไดในครั้งแรกที่

ผใชรองขอ

 

Monkey’s Audio decoder

a	 The Monkey’s Audio SDK and source code can be freely used 

to add APE format playback, encoding, or tagging support 

to any product, free or commercial. Use of the code for 

proprietary efforts that don’t support the off icial APE format 

require written consent of the author.

b	 Monkey’s Audio source can be included in GPL and open-

source software, although Monkey’s Audio itself will not be 

subjected to external licensing requirements or other viral 

source restrictions.

c	 Code changes and improvements must be contributed back 

to the Monkey’s Audio project free from restrictions or 

royalties, unless exempted by express written consent of the 

author.

d	 Any source code, ideas, or libraries used must be plainly 

acknowledged in the software using the code.

e	 Although the software has been tested thoroughly, the 

author is in no way responsible for damages due to bugs or 

misuse.

If you do not completely agree with all of the previous stipulations, you 

must cease using this source code and remove it from your storage 

device.

 

FLAC decoder

Copyright (C) 2000,2001,2002,2003,2004,2005,2006,2007,2008,200

9 Josh Coalson

 

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are 

met:

Redistributions of source code must retain the above •	
copyright notice, this list of conditions and the following 

disclaimer.

Redistributions in binary form must reproduce the above •	
copyright notice, this list of conditions and the following 

disclaimer in the documentation and/or other materials 

provided with the distribution.

Neither the name of the Xiph.org Foundation nor the names •	
of its contributors may be used to endorse or promote 

products derived from this software without specif ic prior 

written permission.

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS 

AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 

THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY 

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 

TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 

THE POSSIBILITY OF SUCH DAMAGE.

 

© 2009, Xiph.Org Foundation

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are 

met: 

Redistributions of source code must retain the above •	
copyright notice, this list of conditions and the following 

disclaimer. 



5

ภ
าษ

าไ
ท

ย

TH

ภ
าษ

าไ
ท

ย

TH

Redistributions in binary form must reproduce the above •	
copyright notice, this list of conditions and the following 

disclaimer in the documentation and/or other materials 

provided with the distribution. 

Neither the name of the Xiph.org Foundation nor the names •	
of its contributors may be used to endorse or promote 

products derived from this software without specif ic prior 

written permission. 

This software is provided by the copyright holders and contributors 

“as is” and any express or implied warranties, including, but not limited 

to, the implied warranties of merchantability and fitness for a particular 

purpose are disclaimed. In no event shall the foundation or contributors 

be liable for any direct, indirect, incidental, special, exemplary, or 

consequential damages (including, but not limited to, procurement of 

substitute goods or services; loss of use, data, or profits; or business 

interruption) however caused and on any theory of liability, whether 

in contract, strict liability, or tort (including negligence or otherwise) 

arising in any way out of the use of this software, even if advised of the 

possibility of such damage

 

XPAT XML Parser

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

 

Permission is hereby granted, free of charge, to any person obtaining 

a copy of this software and associated documentation files (the 

“Software”), to deal in the Software without restriction, including 

without limitation the rights to use, copy, modify, merge, publish, 

distribute, sub-license, and/or sell copies of the Software, and to permit 

persons to whom the Software is furnished to do so, subject to the 

following conditions:

 

The above copyright notice and this permission notice shall be included 

in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF 

ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED 

TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NON-INFRINGEMENT. IN NO EVENT 

SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR 

ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 

OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE 

USE OR OTHER DEALINGS IN THE SOFTWARE.

 

 

การรีไซเคิลผลิตภัณฑ

ผลิตภัณฑของคุณใชวัสดุและสวนประกอบที่มีคุณภาพสูงในการผลิต 

และสามารถนำไปรีไซเคิล หรือนำกลับมาใชใหมได

ผลิตภัณฑที่มีสัญลักษณรูปถังขยะและมีกากบาทขีดทับอย คือผลิตภัณฑที่อยภาย

ใตขอบังคับ European Directive 2002/96/EC:

หามทิ้งผลิตภัณฑรวมกับขยะจากครัวเรือน โปรดศึกษากฎขอบังคับทองถิ่นวาด

วยการแยกเก็บผลิตภัณฑไฟฟาและอิเล็กทรอนิกส การทิ้งผลิตภัณฑที่เสื่อมส

ภาพอยางถูกวิธีจะชวยปองกันไมใหเกิดผลกระทบในทางลบตอสิ่งแวดลอมและ

สุขภาพได

คำเตือน

การถอดแบตเตอร ี ใ่นต วัเคร ื ่องออกส งผลให การร บัประก นัเป นโมฆะและสามารถ••
ทำให ผล ิตภณัฑ เส ียหายได  
คำแนะนำเก ี ่ยวก บัข ั ้ นตอนการถอดและกำจ ดัน ั ้ นเป นข ั ้ นตอนท ี ่สามารถทำไ••
ด เม ื ่อผล ิตภณัฑ หมดอายกุารใช งานแล วเท าน ั ้ น 

ผลิตภัณฑของคุณมีแบตเตอรี่ที่สามารถชารจไฟใหมไดภายใต European 

Directive 2006/66/EC และคุณไมสามารถทิ้งแบตเตอรี่ดังกลาวรวมกับขยะป

กติจากครัวเรือนได 

เพื่อเปนการปกปองการทำงานและความปลอดภัยของผลิตภัณฑของคุณ ใหนำผ

ลิตภัณฑของคุณไปยังศูนยเก็บรวบรวมแบตเตอรี่อยางเปนทางการ หรือศูนยบริกา

รที่มีผเชี่ยวชาญที่สามารถถอดแบตเตอรี่ตามที่แสดงได
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โปรดศึกษากฎขอบังคับทองถิ่นวาดวยการแยกเก็บแบตเตอรี่ การทิ้งแบตเตอรี่อยา

งถูกวิธีจะชวยปองกันไมใหเกิดผลกระทบในทางลบตอสิ่งแวดลอมและสุขภาพได

 

คำประกาศของสหภาพยุโรป 

อุปกรณนี้ถูกตองตามขอกำหนดสัญญาณรบกวนคลื่นวิทยุของสหภาพยุโรป
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2	 MUSE ใหมของคุณ

ใช MUSE เพื่อ

เล นเพลง •	
ด รู ปูภาพ•	
ชมว ิด โีอ•	
ฟ งว ิทย ุ FM•	
ทำการบ นัท ึกเส ียง•	
อ านข อความ•	

ภายในกลองมีอะไรบาง

โปรดตรวจสอบวาคุณไดรับสินคาตามรายการตอไปนี้:

เครื่องเลน

หูฟง

สายเคเบิล USB

คมือเริ่มตนใชงานอยางยอ

Philips GoGear audio player

Quick start guide

หมายเหตุ

ร ปูภาพท ี ่ปรากฏเป นการอ างอ งิเท าน ั ้ น Philips สงวนส ิทธ ิ ์ ในการออกแบบ / ••
ส ีส นัของผล ิตภณัฑ โดยไม ต องแจ งล วงหน า
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3	 การเริ่มตนใชงาน

ภาพรวมการควบคุมและการเชื่อมตอ

a กดค างไว : เป ด/ป ด MUSE

b  / กด: เพ ิ ่ม/ลดระด บัเส ียง
กดค างไว : เพ ิ ่ม/ลดระด บัเส ียงอย างรวดเร ว็

c จอแสดงผล

d กล บัไปยงัเมน หูน าหลกั

e MIC ไมโครโฟน

f แจ ค็ห ฟู ง

g แจ ค็ USB

h RESET ร ีเซ ท็ MUSE

i แจ ค็ HDMI

j MICRO SD ช องเส ียบ Micro SD

เคล็ดลับ

สำหร บัรายละเอ ียดข อม ลูเพ ิ ่มเต ิมเก ี ่ยวก บัการควบค มุโหมดท ี ่ระบ ุ โปรดด ูภาพ••
รวมได ท ี ่ช วงเร ิ ่มต นของบทโหมดในค ม ือผ ใช น ี ้ (เพลง, ว ิด โีอ, อ ื ่นๆ)

ล็อคการควบคุมแบบสัมผัส

คุณสามารถล็อคการควบคุมแบบสัมผัสของ MUSE ได:

1	 กด  เพ ื ่อล อ็คการควบค มุแบบส มัผ สั

หนาจอดับลง»»

การควบคุมแบบสัมผัสทั้งหมดถูกล็อค (การควบคุมระดับเสียง»»

ยังใชงานได)

2	 ในการเป ดหน าจออ ีกคร ั ้ ง ให กดป ุ ่มใดป ุ ่มหน ึ ่งจากสองป ุ ่มน ี ้ :

•	
•	

3	 ใช น ิ ้ วเล ื ่อนแถบล อ็คแนวต ั ้ งบนหน าจอเพ ื ่อปลดล อ็คการควบค ุ

มแบบส มัผ สั

การควบคุมแบบสัมผัสทั้งหมดถูกปลดล็อค»»

การจำกัดระดับเสียง

ขอควรระวัง

การฟ งเส ียงดงัเป นระยะเวลานานอาจเป นอ นัตรายต อผ ฟ ง••

คุณสามารถตั้งคาระดับเสียงของ MUSE เพื่อจำกัดระดับเสียงสูงสุดได

1	 ขณะกำลงัฟ งเพลง ให แตะ  แล วเล ือก [จำกดัระดบัเส ียง]

2	 ใช น ิ ้ วเล ื ่อนสญัลกัษณควบค ุมระด บัเส ียงไปตามแถบบนหน าจอเ

พ ื ่อปร บัระด บัเส ียง

เมื่อคุณตั้งคาจำกัดระดับเสียง MUSE จะไมสามารถปรับระดับเสี»»

ยงเกินระดับที่กำหนดไว แมวาคุณจะกดปุ่มเพื่อเพิ่มระดับเสียง 

หากตองการใชงานระดับเสียงสูงสุด:

1	 ขณะกำลงัฟ งเพลง ให แตะ  แล วเล ือก [จำกดัระดบัเส ียง]

2	 ใช น ิ ้ วเล ื ่อนสญัลกัษณควบค ุมระด บัเส ียงไปตามแถบบนหน าจอไ

ปท ี ่ระด บัส งูสดุ



9

ภ
าษ

าไ
ท

ย

TH

ภ
าษ

าไ
ท

ย

TH

ภาพรวมของเมนูหนาหลัก

คณุสมบตั ิหลกั โหมด เพ ื อ่
เพลง เล นเพลงด ิจ ิตอล
ว ิด โีอ เล นว ิด โีอ
ร ปูภาพ ด รู ปูภาพ
ว ิทย ุ FM ฟ งว ิทย ุ FM

คณุสมบตั ิท ี ป่ร บัปรงุ โหมด เพ ื อ่
การบ นัท ึก สร างหร ือฟ งการบ นัท ึก
Audible ฟ งหนงัส ือเส ียง
ข อความ อ านไฟล ข อความ
โฟลเดอร  ด ไูฟล ในโฟลเดอร 
การต ั ้ งค า ปร บัแต งการต ั ้ งค าของ 

MUSE
การ ด Micro SD¹ ด ขู อม ลูการ ด Micro SD

หมายเหตุ

¹ การ ด Micro SD จะเป นส วนหน ึ ่งของเมน ูเม ื ่อคณุใส การ ด Micro SD ••
ลงในช องเส ียบการ ด Micro SD

การจัดการเมนูหนาหลัก

ในเมน หูน าหลกั คณุสมบ ตั ิหล กัส ี ่ประการจะอย ด านบนและคณุสมบ ตั ิพ ิเศ

ษจะอย ด านล าง คณุสามารถจ ดัการเมน หูน าหลกัอ ีกคร ั ้ งเพ ื ่อให ใช งาน 

ได ง าย โดยการสล บัตำแหน งของไอคอนท ี ่เก ี ่ยวข อง

ในการสลบัตำแหน งระหว างไอคอนสองไอคอน

1	 ตรวจสอบตำแหน งของไอคอน:

ไอคอนหน ึ ่งอย ล างสดุ และอ ีกหน ึ ่งไอคอนอย บนสดุ;•	
หร ืออย ล างสดุท ั ้ งสองไอคอน •	

2	 แตะค างท ี ไ่อคอนหน ึ ่งเพ ื ่อปลดล อ็ค

หากจำเป น ให แตะค างบนไอคอนท ี อ่ย ล างสดุ•	
หนาจอสลัว»»

3	 ลากไอคอนให อย เหน ือไอคอนอ ื ่น 

4	 ปล อยไอคอน 

ตำแหนงของไอคอนทั้งสองจะถูกสลับ »»

หนาจอกลับสความสวางปกติ »»

เชื่อมตอและชารจ

MUSE มีแบตเตอรี่ในตัวซึ่งสามารถชารจผานพอรต USB ของคอมพิวเตอร 

(พรอมสาย USB)

หมายเหตุ

เม ื ่อคณุเช ื ่อมต อ MUSE เข าก บัคอมพ ิวเตอร  จะปรากฏต วัเล ือกอย างย อเพ ื ่••
อเล ือก:

•• [ชาร จและถ ายโอน] หร ือ [ชาร จและเล น]
MUSE จะใช  •• [ชาร จและถ ายโอน] โดยอ ตัโนม ตั ิ หากไม ม ีการเล ือกใหม 



10 THTH

เชื่อมตอ MUSE กับคอมพิวเตอร

1	 เช ื ่อมต อปล ั ๊ ก USB ของสาย USB ท ี ใ่ห มาเข าก บัพอร ต USB 

ท ี ่ว างบนคอมพ ิวเตอร 

2	 เช ื ่อมต อปล ั ๊ ก USB ขนาดเล ก็ ของสาย USB เข าก บัแจ ค็ USB 

ขนาดเล ก็ บน MUSE

3	 เป ดคอมพ ิวเตอร ของคณุ

MUSE ชารจ»»

การติดตั้ง Philips Songbird เปนครั้งแรก

เม ื ่อคณุเช ื ่อมต อ MUSE เข าก บัคอมพ ิวเตอร เป นคร ั ้ งแรก 

หน าต างป อปอ พัจะปรากฏข ึ ้ น:

1	 เล ือก Install Philips Songbird

2	 ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอเพ ื ่อต ิดต ั ้ งให เสร จ็สมบ รูณ 

หมายเหตุ

ในการต ิดต ั ้ ง คณุต องเห น็ด วยก บัเง ื ่อนไขส ิทธ ิ ์ การใช งาน••

หากหน าต างป อปอ พัไม ปรากฏอตัโนม ตั ิ ให ดำเน ินการต อไปน ี ้ :

1	 เล ือก My Computer (Windows XP / Windows 2000) / 

 Computer (Windows Vista / Windows 7)

2	 คล ิกขวาท ี ไ่อคอน Philips GoGear MUSE

3	 เล ือก Install Philips Songbird (Setup.exe)

4	 ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอเพ ื ่อต ิดต ั ้ งให เสร จ็สมบ รูณ 

หมายเหตุ

ในการต ิดต ั ้ ง คณุต องเห น็ด วยก บัเง ื ่อนไขส ิทธ ิ ์ การใช งาน••

การติดตั้งซอฟตแวร Philips Songbird อีกครั้ง 

(ภายหลังจากการติดตั้งครั้งแรก)

ข อสำคญั!

ต วัต ิดต ั ้ งซอฟต แวร  Philips Songbird ม ีใน MUSE 

เพ ื ่อเพ ิ ่มความจหุน วยความจำสำหร บัเน ื ้ อหาส ื ่อบน MUSE ไฟล ต วัต ิด

ต ั ้ งจะถ กูลบโดยอ ตัโนม ตั ิในระหว างข ั ้ นตอนการต ิดต ั ้ งคร ั ้ งแรก 

หากต องการต ิดต ั ้ งซอฟต แวร ภายหลงัการต ิดต ั ้ งคร ั ้ งแรก 

ให ทำตามคำแนะนำเหล าน ี ้ :

1	 เช ื ่อมต อ MUSE ก บัเคร ื ่องคอมพ ิวเตอร 

2	 ตรวจด วู าคอมพ ิวเตอร ได เช ื ่อมต ออ ินเตอร เน ต็แล ว และเป ด 

Windows Explorer

3	 ใน Windows Explorer ให คล ิกขวาบน MUSE 

แล วเล ือกต วัเล ือกเพ ื ่อต ิดต ั ้ ง  Philips Songbird

คอมพิวเตอรจะดาวนโหลดไฟลตัวติดตั้งจากอินเตอรเน็ต»»

4	 ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอเพ ื ่อต ิดต ั ้ งให เสร จ็สมบ รูณ 

การแสดงระดับแบตเตอรี่

หน าจอจะแสดงระด บัสถานะแบตเตอร ี โ่ดยประมาณดงัต อไปน ี ้ :

100% 75% 50% 25% 0%

หนาจอแสดงแบตเตอรี่กะพริบแสดงวาแบตเตอรี่ใกลจะหมด เ»»

ครื่องเลนจะบันทึกการตั้งคาทั้งหมดไวและจะปดเครื่องภายใ

น 60 วินาที

หมายเหตุ

แบตเตอร ี ่แบบชาร จได ม ีจำนวนรอบของการชาร จท ี ่จำก ดั อายกุารใช งานของ••
แบตเตอร ี ่และจำนวนรอบของการชาร จไฟใหม จะแตกต างก นัไปตามการใช งาน
และการต ั ้ งค า
ภาพแอน ิเมช ั ่นแสดงการชาร จจะหยดุลงและ ••  ไอคอนจะปรากฏข ึ ้ นเม ื ่อเส
ร จ็ส ิ ้ นกระบวนการชาร จ

เคล็ดลับ

คณุสามารถประหย ดัพลงังานแบตเตอร ี ่และเพ ิ ่มระยะเวลาในการเล ••
นเพลงของ MUSE ได  หากคณุไปยงั  > [การต ั ้ งค าหน าจอ] > 
[ตวัต ั ้ งเวลาป ดหน าจอ] และตรวจสอบให แน ใจว าได เล ือกการต ั ้ งค าเวลา
ท ี ่ส ั ้ นท ี ่ส ดุแล ว
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ซอฟตแวรที่โหลดบน MUSE

MUSE มาพรอมกับซอฟตแวรดังตอไปนี้: 

•	 Philips Songbird (ช วยคณุอ พัเดตเฟ ร มแวร ของ MUSE 

และถ ายโอนไฟล ส ื ่อ)

ไฟลที่โหลดไปยัง MUSE

ไฟลตอไปนี้ถูกโหลดไปยัง MUSE:

ค ม ือผ ใช •	
คำถามท ี ่พบบ อย•	
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4	 การอัพเดต MUSE

MUSE ถูกควบคุมโดยโปรแกรมภายในเรียกวา เฟรมแวร เฟรมแวรเวอรชันใหมก

วาอาจออกมาหลังจากที่คุณซื้อ MUSE 

โปรแกรมซอฟตแวร Philips Songbird สามารถใชเครื่องคอมพิวเตอรของคุณตร

วจสอบการอัพเดตเฟรมแวรที่มีบนอินเตอรเน็ต 

ติดตั้ง Philips Songbird บนคอมพิวเตอรของคุณ (ดูที่บท 

 การติดตั้งซอฟตแวร) และทำตามคำแนะนำเพื่ออัพเดต (ดูที่บท ตรวจสอบ/ 

อัพเดตเฟรมแวรดวยตนเอง)

หมายเหตุ

ไฟล เพลงของคณุจะไม ได ร บัผลกระทบจากการอ พัเดตเฟ ร มแวร ••

ตรวจสอบ/ อัพเดตเฟรมแวรดวยตนเอง

1	 ตรวจด ใูห แน ใจว าคอมพ ิวเตอร ของคณุได เช ื ่อมต อก บัอ ินเตอร เน ต็

แล ว

2	 เช ื ่อมต อ MUSE ไปยงัคอมพ ิวเตอร  (โปรดด คูำแนะนำในส วน 

 เช ื อ่มต อและชาร จ)

3	 บนคอมพ ิวเตอร ของคณุ คล ิก  เร ิ ม่ > โปรแกรม > Philips > 

 Philips Songbird เพ ื ่อเร ิ ่มใช แอปพล ิเคช นั Philips Songbird 

4	 คล ิก MUSE ในหน าต างเคร ื ่องเล น จากน ั ้ น เล ือก Tools > 

 Check for updated firmware ในหน าต างป อปอ พั 

»» Philips Songbird ตรวจสอบการอัพเดตและติดตั้งเฟรมแวรใหม

จากอินเตอรเน็ต หากมี

5	 ทำตามคำแนะนำบนหน าจอเพ ื ่ออ พัเดตเฟ ร มแวร ของ MUSE

6	 รอจนกระท ั ่งการอ พัเดตเสร จ็สมบ รูณ จากน ั ้ นยกเล ิกการเช ื 

่อมต อ MUSE จากคอมพ ิวเตอร 

MUSE เครื่องเลนจะปด และเปดเครื่องใหม ภายหลังจากการอัพ»»

ดตเฟรมแวรและพรอมสำหรับการเลนอีกครั้ง
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5	 การเปดและปด MUSE

1	 กดค างท ี ่ป ุ ่ม  นานกว า 2 ว ินาท ีเพ ื ่อสล บัไปมาระหว างเป ดและ

ป ด

การปดเครื่องอัตโนมัติ

MUSE มีคุณสมบัติปดเครื่องอัตโนมัติ ซึ่งชวยใหประหยัดพลังงานแบตเตอรี่

หลังจากอยในโหมดพัก 10 นาที (ไมมีการเลนเพลง ไมมีการกดปุ่มใดๆ) MUSE 

จะปดการทำงาน

1	 กดค างท ี ่  นานกว า 2 ว ินาท ีเพ ื ่อเป ดการใช งาน MUSE 

อ ีกคร ั ้ ง

เคล็ดลับ

ค าเร ิ ่มต นต ั ้ งไว ท ี ่ 10 นาท ีเน ื ่องจากเป นโหมดประหย ดัพลงังานส งูท ี ่ส ดุท ี ่เป••
นไปได  คณุสามารถเปล ี ่ยนแปลงโหมดน ี ้ ในการต ั ้ งค า 
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6	 Philips Songbird

MUSE มาพรอมกับซอฟตแวร Philips Songbird

ซอฟตแวร Philips Songbird ชวยคุณในการ:

ซ ื ้ อส ื ่อใหม  (เพลงและว ิด โีอ) แบบออนไลน •	
สร างไลบราร ีส ื ่อ•	
จ ดัการไลบราร ีส ื ่อของคณุ•	
เล นเพลงและว ิด โีอ•	
ซ งิค ส ื ่อของคณุก บั MUSE•	

เมื่อ Philips Songbird เริ่มทำงานเปนครั้งแรก ใหเลือกหนึ่งตัวเลือกจากตัวเลือกต

อไปนี้เพื่ออิมพอรตไฟลสื่อไปในไลบรารีสื่อ Songbird:

อ ิมพอร ตไลบราร ี iTunes ท ี ่ม ี•	
ค นหาไฟล ส ื ่อในไดเรคทอร ีท ี ่ระบ ุ •	
(คณุสามารถเล ือกด โูฟลเดอร ได  ดงัน ั ้ นไฟล ท ี ่ถ กูเพ ิ ่มหร ือลบจะเ

พ ิ ่มหร ือลบในไลบราร ีส ื ่อ Songbird โดยอ ตัโนม ตั ิ)

สรางไลบรารีสื่อ

ใชตัวเลือกหนึ่งตัวหรือมากกวาตอไปนี้เพื่อสรางไลบรารีสื่อดวย Songbird:

ริป CD

ตามค าเร ิ ่มต น ซอฟต แวร  Philips Songbird จะต ิดต ั ้ งไฟล ต อไปน ี ้ ซ ึ ่ง

จำเป นในการร ิป CD:

CD Rip Support•	
Gracenote Metadata Lookup Provider•	

ตั้งคาตัวเลือกริป CD

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือก Tools > Options...

3	 เล ือกแท บ็ CD Rip แล วเล ือกต วัเล ือกร ิป CD ของคณุ

4	 คล ิก OK เพ ื ่อย ืนย นั

อิมพอรตไฟลสื่อจากไดเรคทอรี

ข ั ้ นตอนต อไปน ี ้ แสดงการอ ิมพอร ตไฟล ส ื ่อ (เพลงและว ิด โีอ) 

ท ี ่เก บ็ไว ตามท ี ่ต างๆ ในคอมพ ิวเตอร ของคณุ หร ือเคร ือข ายคอมพ ิวเตอร :

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 บนแถบเคร ื ่องม ือ Songbird คล ิก File แล วเล ือก Import Media...

3	 เล ือกไฟล ส ื ่อ (เพลงและว ิด โีอ) แล วคล ิก OK

ไฟลสื่อที่คุณเก็บไวจะแสดงในไลบรารีสื่อ»»

เคล็ดลับ

หากคณุเล ือกโฟลเดอร ท ี ่ม ไีฟล เพลงหร ือว ิด โีอ ซอฟต แวร จะค นหาโ••
ฟลเดอร และเพ ิ ่มไฟล เพลงหร ือว ิด โีอท ั ้ งหมดท ี ่ม ไีปยงัไลบราร ีส ื ่อ 
(ช ื ่อท ี ่ซ ก นัจะถ กูข ามไป)

อิมพอรตสื่อจาก iTunes

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือก Tools > Options...

3	 บนแถบเคร ื ่องม ือ Songbird เล ือกแท บ็ Media Importer 

แล วเล ือก iTunes Import/Export

4	 ตรวจสอบท ี ่ต ั ้ งไลบราร ีและต วัเล ือก

5	 เล ือก Import Library

ซอฟตแวรจะอิมพอรตไลบรารี iTunes ลงใน Songbird»»

เอ็กซพอรตสื่อไปที่ iTunes

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือก Tools > Options...

3	 บนแถบเคร ื ่องม ือ Songbird เล ือกแท บ็ Media Importer 

แล วเล ือก iTunes Import/Export

4	 ตรวจสอบท ี ่ต ั ้ งไลบราร ีและต วัเล ือก

5	 เล ือก Export Library

ซอฟตแวรจะเอ็กซพอรตไลบรารีจาก Songbird ไปยัง iTunes»»

รับเนื้อหาจากแหลงขอมูลออนไลน

คณุสามารถซ ื ้ อเน ื ้ อหาจากแหล งข อม ลูออนไลน ได  เช น:

7-digital•	
ตรวจสอบข อม ลูจำเพาะของ MUSE เพ ื ่อด วู าม ีบร ิการใดบ างท ี ่คณุใช ได 
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อิมพอรตรายการบันทึกจาก MUSE

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 บนแถบเคร ื ่องม ือ Songbird คล ิก File แล วเล ือก Import Media...

3	 เล ือกรายการท ี ่บ นัท ึก MUSE แล วคล ิก OK

รายการบันทึกที่เลือกจะถูกแสดงในไลบรารีสื่อ»»

เคล็ดลับ

หากคณุเล ือกโฟลเดอร ท ี ่ม ีรายการบ นัท ึก ซอฟต แวร จะค นหาโฟลเดอร และเพ ิ ่ม••
รายการบ นัท ึกท ั ้ งหมดท ี ่ม ไีปยงัไลบราร ี (ช ื ่อท ี ่ซ ก นัจะถ กูข ามไป)

เลือกไลบรารีสื่อของคุณ

ไลบรารีสื่อ Songbird มีโครงสรางดังตอไปนี้:

a

b

c

d

a	 Player Pane (MUSE ถ กูแสดงท ี ่น ี ่)

b	 Library Pane (คณุสามารถค นหาเน ื ้ อหาไลบราร ีของคณุ 

ได ท ี ่น ี ่)

c	 Service Pane (คณุสามารถค นหาข อม ลูเพ ิ ่มเต ิมเก ี ่ยวก บัเน ื ้ อหา 

เช น รายการเพลง ได ท ี ่น ี ่)

d	 Information Pane (คณุสามารถค นหาข อม ลูเก ี ่ยวก บัต วัเล ือกท ี ่เ

ล ือกได ท ี ่น ี ่)

การจัดระเบียบและจัดการไลบรารี่ Songbird

ให Songbird จัดการสื่อของคุณ

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือก Tools > Options…

3	 บนแถบเคร ื ่องม ือ Songbird เล ือกแท บ็ Manage Files 

4	 ทำเคร ื ่องหมายท ี ่ Allow Songbird to manage my files

5	 ต ั ้ งค าต วัเล ือกท ี ่คณุต องการจ ดัการส ื ่อของคณุ

ลบไฟลสื่อออกจากไลบรารีสื่อของ Songbird

1	 ในไลบราร ี Songbird ให คล ิกขวาท ี ไ่ฟล ส ื ่อ แล วเล ือก Remove

2	 ในหน าต างพร อมท  คล ิกท ี ่ Remove เพ ื ่อย ืนย นัว าคณุต องการท ี ่

จะย ายไฟล 

ไฟลที่เลือกจะถูกยายออกจากไลบรารี และรายการเพลงทั้งหมด »»

(ตามคาเริ่มตน ไฟลจะถูก “ยาย” ไมใช “ลบ” จะยังมีไฟลสื่อในที่

ตั้งเดิมของไฟลบนคอมพิวเตอรหรือเครือขายคอมพิวเตอร)

เคล็ดลับ

ในการเล ือกหลายไฟล บนคอมพ ิวเตอร  (PC) ให กดค างท ี ่ •• Ctrl
หากต องการเล ือกหลายไฟล ต อเน ื ่องก นั กดค างท ี ่ •• Shift

การลบสื่อ

ต อไปน ี ้ เป นว ิธ ีการลบไฟล ส ื ่อโดยใช  Windows Explorer:

1	 เม ื ่อเช ื ่อมต อ MUSE ก บัคอมพ ิวเตอร แล ว ให เป ด Windows

2	 ค นหาโฟลเดอร ส ื ่อใน MUSE

3	 ลบไฟล ส ื ่อโดยใช ว ิธ ีเด ียวก นัก บัท ี ่คณุลบไฟล ต างๆ 

บนคอมพ ิวเตอร 

ให Songbird ดูโฟลเดอร

คณุสามารถให  Songbird

ต ิดตามเน ื ้ อหาของโฟลเดอร ได  และ•	
เพ ิ ่มหร ือย ายส ื ่อออกจากไลบราร ีของคณุเพ ื ่อให ตรงก บัเน ื ้ อห•	
าของโฟลเดอร 

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือก Tools > Options...

3	 บนแถบเคร ื ่องม ือ Songbird เล ือกแท บ็ Media Importer 

แล วเล ือก Watch Folders

4	 เล ือกโฟลเดอร ท ี ่ต องการให  Songbird ต ิดตามการเปล ี ่ยนแปลง

โฟลเดอรที่เลือกจะถูกติดตามและ Songbird ทำเนื้อหาไลบรารีใ»»

หตรงกับเนื้อหาของโฟลเดอร
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เรียกใชอารตเวิรคอัลบั้ม

เล ือกจากต วัเล ือกต อไปน ี ้ เพ ื ่อเร ียกอาร ตเว ิร คอ ลับ ั ้ ม:

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

บนแถบเคร ื ่องม ือ Songbird เล ือก •	 Tools > Get Album 

Artwork

หากไมมีการเลือกชื่อเพลง Songbird ซอฟตแวรจะเรียกใชอารตเ»»

วิรคของชื่อเพลงทั้งหมดที่มีในไลบรารี

คล ิกขวาบนช ื ่อท ี ่เล ือก•	
Songbird จะเรียกใชอารตเวิรคของชื่อทั้งหมดที่เลือก»»

รายการเพลง

ตามคาเริ่มตน ซอฟตแวร Philips Songbird จะติดตั้งไฟลตอไปนี้ซึ่งจำเปนใน

การริป CD:

CD Rip Support•	
Gracenote Metadata Lookup Provider•	

สรางรายการเพลง

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือกต วัเล ือกจากต วัเล ือกเหล าน ี ้ เพ ื ่อสร างรายการเพลงใหม :

บนแถบเคร ื ่องม ือ Songbird เล ือก •	 File > New Playlist

คล ิกขวาท ี ่แถบด านข างฝ  ่งซ าย แล วเล ือก •	 New Playlist

คล ิกสญัลกัษณ •	 + ท ี ่อย ด านล างซ ายของ Service Pane

รายการเพลงใหมจะปรากฏใน Service Pane »»

3	 ป อนช ื ่อสำหร บัรายการเพลงใหม 

เพิ่มชื่อไปยังรายการเพลง

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือกหน ึ ่งช ื ่อหร ือมากกว า

3	 เล ือกจากต วัเล ือกเหล าน ี ้ เพ ื ่อเพ ิ ่มช ื ่อท ี ่เล ือกไปยงัรายการเพลง:

ลากแล ววางช ื ่อท ี ่เล ือกใน Service Pane•	
คล ิกขวาบนช ื ่อท ี ่เล ือก จากน ั ้ นเล ือก •	 Add to Playlist > 

 ช ื อ่_ของ_รายการเพลง_ของ_คณุ

ชื่อที่เลือกทั้งหมดจะถูกเพิ่มในรายการเพลง»»

ยายชื่อออกจากรายการเพลง

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 เล ือกรายการเพลง

3	 คล ิกขวาบนช ื ่อท ี ่ต องการย าย แล วเล ือก Remove

ชื่อที่เลือกจะถูกยายออกจากรายการเพลง»»

เปลี่ยนรูปลักษณของไลบรารี Songbird

คุณสามารถเปลี่ยนการออกแบบและเฉดสีของไลบรารี Songbird ได 

เราเรียกขั้นตอนนี้วา “การเปลี่ยนรูปลักษณ” รูปลักษณใหมจะถูกติดตั้งและจัดกา

รเชนเดียวกับการเพิ่มไฟล

คนหารูปลักษณใหม

1	 บนคอมพ ิวเตอร  ให เร ิ ่มโปรแกรม Songbird

2	 บนแถบเคร ื ่องม ือ Songbird เล ือก View > Feathers > Get 

More Feathers…

ซอฟตแวรจะคนหารูปลักษณใหม»»

ทำตามคำแนะนำออนไลนเพื่อติดตั้งรูปลักษณใหม»»

ฟอรแมต MUSE (ลบเพลงและขอมูลทั้งหมด)

Philips Songbird มีคุณสมบัติฟอรแมตเพื่อใชในการฟอรแมต MUSE และลบไ

ฟลทั้งหมดออกจากหนวยความจำภายใน

ขอควรระวัง

ข ั ้ นตอนต อไปน ี ้ เป นการลบไฟล ท ั ้ งหมดท ี ่จ ดัเก บ็ใน MUSE••

1	 ต ิดต ั ้ ง Philips Songbird บนคอมพ ิวเตอร ของคณุ (ด ทู ี ่บท 

 ต ิดต ั ้ งซอฟต แวร ) และเร ิ ่มใช งานโปรแกรม

2	 ในหน าต างเคร ื ่องเล น Philips Songbird ให คล ิกท ี ่ MUSE

3	 ในหน าต างไลบราร ี ให คล ิกบนแท บ็ Tools

4	 ในหน าต าง Tool ให คล ิกท ี ่ Format device

5	 ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอเพ ื อ่ซ อมแซมให เสร จ็สมบ รูณ
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ซอมแซม MUSE (เรียกคืนคาจากโรงงาน)

Philips Songbird มีคุณสมบัติซอมแซมที่ใชในการเรียกคืนการตั้งคาจากโรงงา

นของ MUSE 

กอนดำเนินการ ใหสำรองไฟลที่จัดเก็บใน MUSE หากทำได

ขอควรระวัง

ข ั ้ นตอนต อไปน ี ้ เป นการลบไฟล ท ั ้ งหมดท ี ่จ ดัเก บ็ใน MUSE ••
และเร ียกค ืนการต ั ้ งค าจากโรงงาน

1	 ต ิดต ั ้ ง Philips Songbird บนคอมพ ิวเตอร ของคณุ (ด ทู ี ่บท 

 ต ิดต ั ้ งซอฟต แวร ) และเร ิ ่มใช งานโปรแกรม

2	 ในแถบเมน ู Philips Songbird (ด านบน) ให คล ิกเมน พู ลูดาวน  

 Tools แล วเล ือก Repair My MUSE

3	 ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอเพ ื ่อซ อมแซมให เสร จ็สมบ รู

ณ
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7	 เพลง

เพิ่มเพลงไปยัง MUSE

1	 โปรดด บูท Songbird ในค ม ือผ ใช น ี ้ เพ ื ่อด วู ิธ ีการเพ ิ ่ม (ถ ายโอน) 

ไฟล ส ื ่อ เช น เพลง ไปยงั MUSE

ภาพรวมของการควบคุมเพลง

การควบคุมโหมดเพลงมีดังตอไปนี้:

ความประสงค  การดำเน ินการ
เล น แตะ 2

หยดุช ั ่วคราว แตะ ;

ข ามไปท ี ่จ ดุเร ิ ่มต นของเพลงถ ดัไป แตะ 
ข ามไปท ี ่จ ดุเร ิ ่มต นของเพลงป 

จจบุ นั

แตะ 

ข ามเด ินหน าภายในเพลง แตะค างท ี ่ 
ข ามถอยหลงัภายในเพลง แตะค างท ี ่ 
ด ูเมน ตู วัเล ือก แตะ 
เพ ิ ่ม / ลดระด บัเส ียง กดป ุ ่ม  /  ระด บัเส ียง
ไปยงัหน าจอเล นท ี ใ่ช งาน แตะ 

เลือกอัลบั้มเพลง

สามารถเลือกไลบรารี่เพลงตามปกอัลบั้มไดดังนี้:

1	 แตะ  เพ ื ่อแสดงม มุมองเบราเซอร 

2	 ใช น ิ ้ วเล ื ่อนจากซ ายไปขวาหร ือจากขวาไปซ ายบนหน าจอเพ ื ่อเ

ล ือกปกอลับ ั ้ ม

ฟงเพลง

1	 ในเมน หูน าหลกั ให แตะ  เพ ื ่อเข าส โหมดเพลง

ไลบรารี่เพลงถูกแสดงในแถวที่คุณสามารถปรับแตงเองได:»»

แตะ »»  เพื่อดูตัวเลือกมุมมองไลบรารี่ 

และแตะเพื่อเลือกตัวเลือกมุมมอง

2	 ใช น ิ ้ วเล ื ่อนข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการเพลง

3	 เม ื ่อพบเพลงท ี ่ต องการ ให แตะเพ ื ่อเร ิ ่มเล น

แตะ •	 ; เพ ื ่อหยดุเล นช ั ่วคราว

แตะ •	 2 เพ ื ่อเร ิ ่มเล นใหม 

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

ขณะกำลังเลนเพลง คุณสามารถเลือกคุณสมบัติการเลนขั้นสูงไดดังนี้:

แตะแถบการจ ดัอ นัด บัหน ึ ่งคร ั ้ งหร ือมากกว าเพ ื ่อเล ือกต วัเล ือก•	
การจ ดัอ นัด บั

•	  (ไม จ ดัอ นัด บั)

•	  (อ นัด บั 1)

•	  (อ นัด บั 2)

•	  (อ นัด บั 3)

•	  (อ นัด บั 4)

•	  (อ นัด บั 5)

แตะ •	  หน ึ ่งคร ั ้ งหร ือมากกว าเพ ื ่อเล ือกต วัเล ือกการเล นซ ด ั

งน ี ้ :

เล นซ  1 (เล นซ เพลงป จจบุ นั)•	
ซ ท ั ้ งหมด (เล นซ เพลงท ี ่เล ือกป จจบุ นัท ั ้ งหมด)•	
ป ดการเล นซ  (ไม เล นซ เพลงใดๆ)•	

แตะ •	  เพ ื ่อเล นเพลงในไลบราร ี ่ท ี ่เล ือกป จจบุ นัโดยส มการเร ีย

งลำด บั

แตะ •	  เพ ื ่อด ตู วัเล ือกเพลงเพ ิ ่มเต ิม เช น 

การต ั ้ งค าอ ีควอไลเซอร และ FullSound
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ปรับแตงมุมมองไลบรารี่เพลง

ในโหมดเพลง คุณสามารถเปลี่ยนวิธีการดูเพลงในไลบรารี่ได:

1	 แตะ  เพ ื ่อด ตู วัเล ือกม มุมองไลบราร ี :่

ศ ิลป นและอลับ ั ้ ม (แสดงรายการสามแถวค ือ ศ ิลป น, •	
อลับ ั ้ ม และช ื ่อเพลงโดยเร ียงตามลำด บัต วัอ กัษร)

ศ ิลป น (แสดงรายการสองแถวค ือ ศ ิลป นและช ื ่อเพลงโดยเ•	
ร ียงตามลำด บัต วัอ กัษร)

อ ลับ ั ้ ม (แสดงรายการสองแถวค ือ อ ลับ ั ้ มและช ื ่อเพลงโด•	
ยเร ียงตามลำด บัต วัอ กัษร)

ทกุเพลง (แสดงรายการหน ึ ่งแถวค ือ ช ื ่อเพลงท ั ้ งหมดโดยเ•	
ร ียงตามลำด บัต วัอ กัษร)

รายการเพลง (แสดงรายการสองแถวค ือ รายการเพลงและช ื ่•	
อเพลงโดยเร ียงตามลำด บัต วัอ กัษร)

2	 แตะม มุมองท ี ่ต องการใช 

ไลบรารี่จะแสดงตามมุมมองที่นำมาใช»»

ลบเพลงที่กำลังเลน

1	 ขณะกำลงัฟ งเพลง ให แตะ 

2	 แตะต วัเล ือกเพ ื ่อลบเพลง

3	 แตะเพ ื ่อย ืนย นัการลบ

ลบเพลงหนึ่งเพลงหรือมากกวา

1	 ใช ซอฟต แวร  Philips Songbird เพ ื ่อเพ ิ ่มหร ือลบ 

และซ งิค ไฟล ส ื ่อของคณุ เช น เพลง

หมายเหตุ

หร ือคณุอาจเล ือก ••  จากเมน หูลกัและค นหาไฟล ของคณุในม มุมองโฟลเดอร 
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8	 หนังสือเสียง

MUSE รองรับหนังสือในรูปแบบไฟลเสียง ในการใชคุณสมบัตินี้ 

คุณตองดาวนโหลด AudibleManager จาก audible.com ดวย 

 AudibleManager คุณสามารถจัดการขอมูลดิจิตอลหนังสือเสียงของคุณได

โปรดไปที่ audible.com และลงทะเบียน คำแนะนำบนหนาจอนำคุณไปสขั้นตอ

นการดาวนโหลดซอฟตแวร AudibleManager

การเพิ่มหนังสือภาพลงใน MUSE

ขอสำคัญ: MUSE รองรับรูปแบบหนังสือเสียง  หรือรูปแบบ 

1	 เร ิ ่มใช  AudibleManager บนคอมพ ิวเตอร ของคณุ

2	 ปฏ ิบ ตั ิตามคำแนะนำออนไลน  เพ ื ่อดาวน โหลดหนงัส ือเส ียงของค ุ

ณในร ปูแบบ  หร ือร ปูแบบ 

3	 ปฏ ิบ ตั ิตามคำแนะนำบนหน าจอของ AudibleManager 

เพ ื ่อเป ดใช งาน MUSE สำหร บัหนงัส ือเส ียงของคณุ 

4	 ปฏ ิบ ตั ิตามคำแนะนำบนหน าจอของ AudibleManager เพ ื ่อถ ายโ

อนหนงัส ือเส ียงของคณุไปท ี ่ MUSE

หมายเหตุ

MUSE สามารถเล นได เฉพาะหนงัส ือเส ียงท ี ่ •• activated เท าน ั ้ น

ภาพรวมการควบคุมหนังสือเสียง

การควบคุมโหมดหนังสือเสียงมีดังตอไปนี้:

ความประสงค  การดำเน ินการ
เล น แตะ 2

หยดุช ั ่วคราว แตะ ;

ไปท ี ่จ ดุเร ิ ่มต นของส วน/บทใหม  แตะ 
ไปท ี ่จ ดุเร ิ ่มต นของส วน/บทป จจบุ นั แตะ 
ข ามเด ินหน าภายในหนงัส ือเส ียง แตะค างท ี ่ 
ข ามถอยหลงัภายในหนงัส ือเส ียง แตะค างท ี ่ 
ด ูเมน ตู วัเล ือก แตะ 
เพ ิ ่ม / ลดระด บัเส ียง กดป ุ ่ม  /  ระด บัเส ียง
เพ ิ ่ม / ลดความเร ว็ในการเล น แตะ  / 

ไปยงัหน าจอเล นท ี ใ่ช งาน แตะ 

เลือกหนังสือเสียง

สามารถเลือกไลบรารี่หนังสือเสียงตามปกหนังสือไดดังนี้:

1	 แตะ  เพ ื ่อแสดงม มุมองเบราเซอร 

2	 ใช น ิ ้ วเล ื ่อนจากซ ายไปขวาหร ือจากขวาไปซ ายบนหน าจอเพ ื ่อเ

ล ือกปกหนงัส ือ
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ฟงหนังสือเสียง

1	 ในเมน หูน าหลกั ให แตะ  เพ ื ่อป อนโหมดหนงัส ือเส ียง

หน าจอเล นหนงัส ือเส ียงม ีแผงควบค มุ 3 รายการ:

แผงควบค มุบน: ต วัเล ือกต างๆ•	
แผงควบค มุกลาง: หนงัส ือเส ียงป จจบุ นั•	
แผงควบค มุล าง: การควบค มุต างๆ•	

2	 ใช น ิ ้ วเล ื ่อนข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการหนงัส ือเ

ส ียง

3	 เม ื ่อพบหนงัส ือเส ียงท ี ่ต องการ ให แตะเพ ื ่อเร ิ ่มเล น

แตะ •	 ; เพ ื ่อหยดุเล นช ั ่วคราว

แตะ •	 2 เพ ื ่อเร ิ ่มเล นใหม 

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

ขณะกำลังเลนหนังสือเสียง คุณสามารถเลือกคุณสมบัติการเลนขั้นสูงไดดังนี้:

แตะแถบการจ ดัอ นัด บัหน ึ ่งคร ั ้ งหร ือมากกว าเพ ื ่อเล ือกต วัเล ือก•	
การจ ดัอ นัด บั

•	  (ไม จ ดัอ นัด บั)

•	  (อ นัด บั 1)

•	  (อ นัด บั 2)

•	  (อ นัด บั 3)

•	  (อ นัด บั 4)

•	  (อ นัด บั 5)

แตะ •	  เพ ื ่อเพ ิ ่มบ คมาร คท ี ่ตำแหน งป จจบุ นัในหนงัส ือเส ียง

แตะ •	  เพ ื ่อด ตู วัเล ือกหนงัส ือเส ียงเพ ิ ่มเต ิม

ปรับแตงมุมมองไลบรารี่หนังสือเสียง

ในโหมดหนังสือเสียง คุณสามารถเปลี่ยนวิธีการดูหนังสือเสียงในไลบรารี่ได:

1	 แตะ  เพ ื ่อด ตู วัเล ือกม มุมองไลบราร ี :่

ผ แต ง (แสดงรายการหน ึ ่งแถวค ือรายการผ แต งท ั ้ งหมดโดยเร ี•	
ยงตามลำด บัต วัอ กัษร)

หนงัส ือ (แสดงรายการหน ึ ่งแถวค ือ ช ื ่อเร ื ่องท ั ้ งหมดโดยเ•	
ร ียงตามลำด บัต วัอ กัษร)

2	 แตะม มุมองท ี ่ต องการใช 

ไลบรารี่จะแสดงตามมุมมองที่นำมาใช»»



22 THTH

9	 BBC iPlayer (มีบริการเฉพาะในสหราช

อาณาจักรเทานั้น)

ดวย BBC iPlayer คุณสามารถติดตามโปรแกรม BBC จาก 7 วันที่ผานมาบน 

MUSE

วิธีการใช BBC iPlayer บน Philips MUSE:

1	 ในคอมพ ิวเตอร ของคณุ เป ดเบราเซอร ของคณุและไปท ี ่ www.

bbc.co.uk/iplayer

2	 คล ิกบนโปรแกรมเพ ื ่อเล ือก

3	 วางเมาส เหน ือป ุ ่ม Download  ท ี ่ด านขวาล างของหน าจอ

4	 คล ิกต วัเล ือก: For portable devices  เพ ื ่อเร ิ ่มดาวน โหลด

5	 เม ื ่อคณุเห น็หน าจอเช นน ี ้ ให คล ิก Continue

6	 อ ีกส กัคร  คณุจะเห น็ต วัเล ือกการดาวน โหลด คล ิกท ี ่  Download  เ

พ ื ่อบ นัท ึกโปรแกรมลงบนคอมพ ิวเตอร ของคณุ

หลังจากทำตามขั้นตอนนี้ ไฟลของคุณควรจะไดรับการดาวนโหล»»

ดเสร็จสมบูรณแลว

เมื่อดาวนโหลดไฟลแลว คุณสามารถใช Windows 

ExplorerหรือWindows Media Player 

11เพื่อถายโอนไฟลไปยัง MUSE

7	 เช ื ่อมต อ MUSE เข าก บัคอมพ ิวเตอร ของคณุแล วถ ายโอนไฟล ด วย 

A Windows Explorer หร ือ B Windows Media Player 11

A	 ถายโอนดวย Windows Explorer

ข อสำคญั: ก อนการถ ายโอนไฟล ด วย •	 Windows Explorer ใ

ห เล นไฟล บนคอมพ ิวเตอร เคร ื ่องท ี ่คณุใช อย ส กัคร  (ประมาณ 

10 ว ินาท ี) Windows Media Player 11

ขณะกำลงัถ ายโอน อาจปรากฏป อปอ พัข อความของ •	
Windows ข ึ ้ นดงัน ี ้ คล ิกบน Yes หร ือ Yes to All 

เพ ื ่อดำเน ินการต อ
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B	 ถ ายโอนด วยWindows Media Player 11

ข อสำคญั: ก อนจะเช ื ่อมต อเคร ื ่องเล น GoGear •	
เข าก บัคอมพ ิวเตอร ของคณุ โปรดตรวจสอบให แน ใจว าคณุไ

ด เล ือก [MTP] ใน  > [การต ั ้ งค าการเช ื อ่มต อ PC]

โปรดด ไูฟล ว ิธ ีใช ของ Windows Media Player 11 •	
สำหร บัรายละเอ ียดเพ ิ ่มเต ิม

หมายเหตุ

โปรแกรม BBC iPlayer แต ละโปรแกรมจะได ร บัการป องก นัส ิทธ ิ ์ ด วย Digital ••
License และสามารถซ งิโครไนซ ได ถ งึ 5 คร ั ้ งก บัอปุกรณพกพาใดๆ
สำหร บัข อม ลูข อกำหนดของระบบ โปรดด ใูนค ม ือผ ใช และค ม ือการใช งานอย างย อ••
สามารถดาวน โหลด BBC iPlayer ได เฉพาะก บัคอมพ ิวเตอร ท ี ่ม ี •• Windows XP 
(SP2 หร ือส งูกว า) และม ีการต ิดต ั ้ ง Windows Media Player 11

•• BBC iPlayer ม ีบร ิการเฉพาะในสหราชอาณาจกัรเท าน ั ้ น

เมื่อฉันทดลองดาวนโหลดโปรแกรม มีขอความใหฉันติดตั้งโปรแกรมเสริ

ม ฉันควรติดตั้งหรือไม

หากคณุพบข อความดงักล าวในเบราเซอร ของคณุ 

ให ทำตามคำแนะนำท ี ่ปรากฏบนหน าจอ : 

ต ิดต ั ้ ง Active-X Object ท ี ่เบราเซอร ของคณุจำเป นต อง 

ใช ทำงาน (คล ิกส วนส ีเหล ืองท ี ่ด านบนหน าจอท ี ่แสดงข อความน ี ้ ) 

หลงัจากการต ิดต ั ้ ง คณุควรจะสามารถดาวน โหลดโปรแกรมได ตามปกต ิ

เมื่อฉันลองดาวนโหลดโปรแกรม มีขอความใหฉันอัปเกรดซอฟตแวร 

Windows Media Player…

ไปตามล งิค ท ี ่ม ีในข อความ Software Upgrade Required 

เพ ื ่ออ ปัเกรดการต ิดต ั ้ ง Windows Media Player

ฉันไมเห็นตัวเลือกการดาวนโหลดในโปรแกรมที่ฉันตองการดู

บางโปรแกรมไม พร อมให ดาวน โหลดในขณะน ี ้

เมื่อฉันลากแลววางวิดีโอไฟลที่ฉันดาวนโหลดมา 

ฉันไดรับขอความดังตอไปนี้

ฉันตองทำสิ่งใด

ไม ต องสนใจข อความน ี ้ (คล ิก Yes หร ือ Yes to All) ไฟล จะถ ายโอนและเ

ล นบนอปุกรณของคณุโดยไม ม ีป ญหา

สำหร บัว ิธ ีใช เพ ิ ่มเต ิมของ BBC iPlayer โปรดเย ี ่ยมชม http://

iplayerhelp.external.bbc.co.uk/help/download_programmes/

sideloading
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10	 วิดีโอ

เพิ่มวิดีโอไปยัง MUSE

1	 โปรดด บูท Songbird ในค ม ือผ ใช น ี ้ เพ ื ่อด วู ิธ ีการเพ ิ ่ม (ถ ายโอน) 

ไฟล ส ื ่อ เช น ว ิด โีอ ไปยงั MUSE

ภาพรวมการควบคุมวิดีโอ

การควบคุมโหมดวิดีโอมีดังตอไปนี้:

ความประสงค  การดำเน ินการ
เล น แตะ 2

หยดุช ั ่วคราว แตะ ;

ข ามไปท ี ่จ ดุเร ิ ่มต นของว ิด โีอถ ดัไป แตะ 
ข ามไปท ี ่จ ดุเร ิ ่มต นของว ิด โีอป จจบุ นั แตะ 
ข ามเด ินหน า / ถอยหลงัภายในว ิด โีอ แตะ  และแตะท ี ่ตำแหน งบน

แถบความค ืบหน า
ด ูเมน ตู วัเล ือก แตะ 
เพ ิ ่ม / ลดระด บัเส ียง กดป ุ ่ม  /  ระด บัเส ียง
ไปยงัหน าจอเล นท ี ใ่ช งาน แตะ 

เลือกอัลบั้มวิดีโอ

สามารถเลือกไลบรารี่วิดีโอตามปกอัลบั้มไดดังนี้:

1	 แตะ  เพ ื ่อแสดงม มุมองเบราเซอร 

2	 ใช น ิ ้ วเล ื ่อนจากซ ายไปขวาหร ือจากขวาไปซ ายบนหน าจอเพ ื ่อเ

ล ือกปกอลับ ั ้ ม

การเลนวิดีโอ

1	 ในเมน หูน าหลกั ให แตะ  เพ ื ่อเข าส โหมดว ิด โีอ

2	 ใช น ิ ้ วเล ื ่อนข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการว ิด โีอ

3	 เม ื ่อพบว ิด โีอท ี ่ต องการ ให แตะเพ ื ่อเร ิ ่มเล น

หน าจอเล นว ิด โีอม ีแผงควบค มุ 3 รายการ:

แผงควบค มุบน: ต วัเล ือกต างๆ•	
แผงควบค มุกลาง: ว ิด โีอป จจบุ นั•	
แผงควบค มุล าง: การควบค มุต างๆ•	

แตะ •	 ; เพ ื ่อหยดุเล นช ั ่วคราว

แตะ •	 2 เพ ื ่อเร ิ ่มเล นใหม 

แตะ •	  เพ ื ่อย อนกล บัไปยงัเมน รูาก

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

ขณะกำลังเลนวิดีโอ คุณสามารถเลือกคุณสมบัติการเลนขั้นสูงไดดังนี้:

แตะแถบการจ ดัอ นัด บัหน ึ ่งคร ั ้ งหร ือมากกว าเพ ื ่อเล ือกต วัเล ือก•	
การจ ดัอ นัด บั

•	  (ไม จ ดัอ นัด บั)

•	  (อ นัด บั 1)

•	  (อ นัด บั 2)

•	  (อ นัด บั 3)

•	  (อ นัด บั 4)

•	  (อ นัด บั 5)

แตะ •	  เพ ื ่อเปล ี ่ยนจากม มุมองปกต ิเป นม มุมองเต ม็หน าจอ

แตะหน าจอเพ ื ่อแสดงต วัเล ือกและการควบค ุม•	
แตะ •	  เพ ื ่อเปล ี ่ยนจากม มุมองเต ม็หน าจอเป นม มุมองปกต ิ

แตะ •	  เพ ื ่อเปล ี ่ยนจากการเล นปกต ิเป นโหมดค นหาว ิด โีอ 

จากน ั ้ น

แตะท ี ่แถบความค ืบหน า •	 a (ด ูภาพ) ในแผงควบค มุเพ ื 

่อข ามไปยงัตำแหน งท ี ่ระบ ุภายในว ิด โีอท ี ่กำลงัเล น;

แตะแถบควบค มุความเร ว็ •	 b (ด ูภาพ) 

ในแผงควบค มุเพ ื ่อเพ ิ ่ม/ลดความเร ว็ในการเล นเด ินหน า/

ถอยหลงัซ ึ ่งปร บัได ส งูสดุถ งึ 5 เท าของความเร ว็ปกต ิ:
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แตะ •	  เพ ื ่อด ตู วัเล ือกว ิด โีอเพ ิ ่มเต ิม เช น ความสว างและ 

 Surround for movies

การเลนวิดีโอบนทีวี HD

สามารถเลนคลิปวิดีโอจากเครื่องเลนบนทีวี HD ของคุณไดดังนี้:

1	 ทำตามข ั ้ นตอนในบท “การเล นว ิด โีอ” เพ ื ่อเล นว ิด โีอ

2	 เช ื ่อมต อปล ั ๊ กขนาดเล ก็ของสาย HDMI (แยกจำหน าย) 

เข าก บัเคร ื ่องเล น

3	 เป ดท ีว ี HD

4	 เช ื ่อมต อปล ั ๊ กขนาดใหญของสาย HDMI (แยกจำหน าย) 

เข าก บัแจ ค็ช อง HDMI บนท ีว ี HD ของคณุ

วิดีโอเลนบนทีวี HD ของคุณ»»

แตะหน าจอบน MUSE สำหร บัต วัเล ือกการเล นและเล ื ่อนด ู•	

เคล็ดลับ

หากคณุถอดสาย HDMI ออก การเล นว ิด โีอบนท ีว ี HD จะกล บัไปเล นต อหลงัจา••
กท ี ่คณุเช ื ่อมต อปล ั ๊ ก HDMI แล วสองสามว ินาท ี

ปรับแตงมุมมองไลบรารี่วิดีโอ

ในโหมดวิดีโอ คุณสามารถเปลี่ยนวิธีการดูวิดีโอในไลบรารี่ได:

1	 แตะ  เพ ื ่อด ตู วัเล ือกม มุมองไลบราร ี :่

ว ิด โีอท ั ้ งหมด (แสดงรายการหน ึ ่งแถวค ือ ช ื ่อว ิด โีอท ั ้ ง•	
หมดโดยเร ียงตามลำด บัต วัอ กัษร)

รายการว ิด โีอ (แสดงต วัเล ือกม มุมองรายการว ิด โีอเพ ิ ่ม•	
เต ิม)

2	 แตะม มุมองท ี ่ต องการใช 

ไลบรารี่จะแสดงตามมุมมองที่นำมาใช»»

การลบวิดีโอที่กำลังเลน

1	 ขณะกำลงัด วู ิด โีอ ให แตะ 

2	 แตะต วัเล ือกเพ ื ่อลบว ิด โีอ

3	 แตะเพ ื ่อย ืนย นัการลบ

การลบวิดีโอหนึ่งวิดีโอหรือมากกวา

ใชซอฟตแวร Philips Songbird เพื่อเพิ่มหรือลบ และซิงคไฟลสื่อของคุณ เชน 

วิดีโอ

หมายเหตุ

หร ือคณุอาจเล ือก ••  จากเมน หูลกัและค นหาไฟล ของคณุในม มุมองโฟลเดอร 
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11	 รูปภาพ

เพิ่มรูปภาพลงใน MUSE

1	 โปรดด บูท Songbird ในค ม ือผ ใช น ี ้ เพ ื ่อด วู ิธ ีการเพ ิ ่ม (ถ ายโอน) 

ไฟล ส ื ่อ เช น ร ปูภาพ ไปยงั MUSE

ภาพรวมการควบคุมภาพ

การควบคุมโหมดภาพมีดังตอไปนี้:

ความประสงค  การดำเน ินการ
เล นภาพสไลด  แตะ 2

หยดุภาพสไลด ช ั ่วคราว แตะ ;

ข ามไปท ี ่ภาพถดัไป แตะ 
ข ามไปท ี ่ภาพก อนหน า แตะ 
ด ูเมน ตู วัเล ือก แตะ 
ขยายภาพ (ซ ูมเข า) แตะ  แล วแตะแถบควบค มุการซ ูม
หมนุภาพตามเข ม็นาฬ ิกา 90 องศา แตะ 
ไปท ี ่หน าจอท ี ใ่ช งาน แตะ 

เลือกอัลบั้มภาพ

คุณสามารถเลือกไลบรารี่ภาพในมุมมองอัลบั้มไดดังนี้:

1	 แตะ  เพ ื ่อแสดงม มุมองเบราเซอร 

2	 ใช น ิ ้ วเล ื ่อนจากซ ายไปขวาหร ือจากขวาไปซ ายบนหน าจอเพ ื ่อเ

ล ือกปกอลับ ั ้ ม

ดูรูปภาพ

1	 ในเมน หูน าหลกั ให แตะ  เพ ื ่อเข าส โหมดภาพ

หนาจอแสดงภาพมีสองสวนคือ: รายการอัลบั้มและมุมมองภาพขน»»

าดเล็กของภาพในอัลบั้มที่เลือก

2	 เล ื ่อนน ิ ้ วข ึ ้ นและลงบนรายการอ ลับ ั ้ มเพ ื ่อค นหาอ ลับ ั ้ ม 

จากน ั ้ นแตะเพ ื ่อเล ือกอ ลับ ั ้ ม

3	 ในพ ื ้ นท ี ่ม มุมองภาพขนาดเล ก็ ให แตะบนภาพเพ ื ่อด ูภาพในโหม

ดเต ม็หน าจอ

แตะ •	 2 เพ ื ่อด ูภาพในอลับ ั ้ มท ี ่เล ือกเป นภาพสไลด  

โดยเร ิ ่มต นด วยภาพท ี ่กำลงัแสดง

แตะ •	  เพ ื ่อด ูภาพและต วัเล ือกภาพสไลด เพ ิ ่มเต ิม

แตะ •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

การแสดงภาพขั้นสูง

ขณะกำลังเลนภาพ สามารถเลือกคุณสมบัติการแสดงภาพขั้นสูงดังนี้:

แตะ •	  เพ ื ่อเข าส โหมดซ ูม จากน ั ้ นแตะแถบควบค มุการซ ูมในแผ

งควบค มุ:

แตะ * ด านขวาของแถบควบค มุการซ ูมเพ ื ่อเพ ิ ่มระด บัการ•	
ขยายโดยสามารถขยายได ส งูสดุถ งึ 4 เท าของขนาดปกต ิ

แตะ * ด านซ ายของแถบควบค มุการซ ูมเพ ื ่อลดระด บัการข•	
ยาย (ขนาดเล ก็สดุ: ขนาดปกต ิ)

แตะสองคร ั ้ งท ี ่ภาพเพ ื ่อกล บัไปยงัม มุมองขนาดปกต ิ•	
แตะ •	  เพ ื ่อด ตู วัเล ือกภาพเพ ิ ่มเต ิม เช น การต ั ้ งเวลาภาพสไลด 

เคล็ดลับ

เม ื ่อภาพท ี ่ขยายม ีขนาดใหญกว าหน าจอ สามารถใช น ิ ้ วลากภาพภายในหน ••
าจอได 
* คณุสามารถลากสญัลกัษณของแถบควบค มุการซ ูมไปด านซ าย / ขวาเพ ื ่อเพ ิ ่ม/••
ลดระด บัการขยาย
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ดูภาพบนทีวี

สามารถดูภาพจากเครื่องเลนบนทีวีของคุณไดดังนี้:

1	 ทำตามข ั ้ นตอนในบท “การด ูภาพ” เพ ื ่อด ูภาพ

2	 เช ื ่อมต อปล ั ๊ กขนาดเล ก็ของสาย HDMI (แยกจำหน าย) 

เข าก บัเคร ื ่องเล น

3	 เป ดท ีว ี

4	 เช ื ่อมต อปล ั ๊ กขนาดใหญของสาย HDMI (แยกจำหน าย) 

เข าก บัแจ ค็ช อง HDMI บนท ีว ีของคณุ

ภาพจะแสดงบนทีวีของคุณ»»

แตะหน าจอบน MUSE เพ ื ่อแสดงภาพ •	
เล ื ่อนด ูและด ตู วัเล ือกภาพสไลด 

เคล็ดลับ

หากคณุถอดสาย HDMI ออก การเล นภาพบนท ีว ีจะกล บัไปเล นต อหลงัจากท ี ่คณุ••
เช ื ่อมต อปล ั ๊ ก HDMI แล วสองสามว ินาท ี

การลบภาพที่กำลังแสดง

1	 ขณะกำลงัด ูภาพในโหมดเต ม็หน าจอ ให แตะ 

2	 แตะต วัเล ือกเพ ื ่อลบร ปูภาพ

3	 แตะเพ ื ่อย ืนย นัการลบ

การลบภาพหนึ่งภาพหรือมากกวา

1	 ใช ซอฟต แวร  Philips Songbird เพ ื ่อเพ ิ ่มหร ือลบ 

และซ งิค ไฟล ส ื ่อของคณุ เช น ร ปูภาพ

หมายเหตุ

หร ือคณุอาจเล ือก ••  จากเมน หูลกัและค นหาไฟล ของคณุในม มุมองโฟลเดอร 
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12	 วิทยุ

ฟงวิทยุ FM

MUSE สามารถจัดเก็บสถานีวิทยุที่แตกตางกันไดถึง 20 สถานีโดยจัดเก็บเปนหม

ายเลขที่ตั้งไวลวงหนา 

ทำตามขั้นตอนในบท ปรับคลื่นสถานีวิทยุอัตโนมัติ เพื่อหาคลื่นสถานีวิทยุโ

ดยอัตโนมัติ 

คุณสมบัติหาคลื่นอัตโนมัติจะบันทึกสัญญาณวิทยุที่แรงกวา 20 สถานีแรก 

เปนหมายเลขที่ตั้งไวลวงหนา

หมายเหตุ

คณุสามารถหาคล ื ่นสถาน ีว ิทยดุ วยตนเองได อ ีกด วย (ด ขู อม ลูเพ ิ ่มเต ิมท ี ่บท ••
 การหาคล ื ่นสถาน ีว ิทยดุ วยตนเอง)

1	 ในเมน หูน าหลกั ให แตะ  เพ ื ่อเข าส โหมดว ิทย ุ

สายเคเบิลหูฟงทำหนาที่เปนเสาอากาศวิทยุ FM »»

2	 แตะ  เพ ื ่อแสดงสถาน ีท ี ่ต ั ้ งไว ล วงหน า

3	 แตะหมายเลขท ี ่ต ั ้ งไว ล วงหน าเพ ื ่อฟ งสถาน ีว ิทยทุ ี ่ถ กูบ นัท ึก 

ไว ท ี ่หมายเลขน ั ้ น

กด •	  เพ ื ่อหยดุเส ียงว ิทย ุ

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

การหาคลื่นสถานีวิทยุที่ตั้งไวลวงหนาอัตโนมัติ

คุณสมบัติการหาคลื่นอัตโนมัติของ MUSE ชวยใหคุณคนหาสถานีวิทยุที่คุณตองก

ารและบันทึกเปนหมายเลขที่ตั้งไว

1	 ขณะอย ในโหมดว ิทย แุละเส ียบห ฟู ง ให แตะ  เพ ื ่อด ูเมน ตู วัเล ือก

2	 แตะต วัเล ือกเพ ื ่อหาคล ื ่นอ ตัโนม ตั ิ 

หากโปรแกรมให คณุดำเน ินการ ให แตะเพ ื ่อย ืนย นั•	
วิทยุจะหาคลื่นสถานีวิทยุโดยอัตโนมัติและบันทึกคลื่นความถี่ที่แร»»

งกวา 20 คลื่นแรกเปนหมายเลขที่ตั้งไวลวงหนา 

สำหรับสถานีที่รองรับ RDS (Radio Data System) »»

จะแสดงขอมูลสถานีเพิ่มเติมดวย

การหาคลื่นสถานีวิทยุดวยตนเอง

ขณะอยในโหมดวิทยุ คุณสามารถหาคลื่นสถานีวิทยุไดดวยตนเอง:

1	 เล ื ่อนน ิ ้ วจากซ ายไปขวาหร ือจากขวาไปซ ายบนช วงการหาคล ื ่น

ท ี ่อย ด านล างของหน าจอเพ ื ่อเพ ิ ่ม/ลดความถ ี ่ด วยตนเอง

แตะ •	  เพ ื ่อด ตู วัเล ือกว ิทย เุพ ิ ่มเต ิม

เคล็ดลับ

แถวแนวต ั ้ งบนช วงการหาคล ื ่นแสดงความถ ี ่ของสถาน ีว ิทยทุ ี ่ถ กูบ นัท ึกเป นห••
มายเลขท ี ่ต ั ้ งไว ล วงหน า
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13	 การบันทึก

การบันทึกจากวิทยุ FM (มีอยในบางรนเทานั้น!)

1	 ขณะกำลงัฟ งว ิทย ุ FM ให แตะ  เพ ื ่อเข าส โหมดการบ นัท ึก

แตะ •	  เพ ื ่อเร ิ ่มการบ นัท ึก

แตะ •	 ; /  เพ ื ่อสล บัระหว างการบ นัท ึกและหยดุช ั ่วคราว

แตะ •	 9 เพ ื ่อหยดุ

เสียงที่ตองการไดถูกบันทึกไวในเครื่องเลนโดยอัตโนมัติแล»»

ว (รูปแบบไฟลชื่อ: FMREC YYYY-MM-DD XXX.MP3 ซึ่ง 

YYYY-MM-DD คือป เดือนและวันที่บันทึก และ XXX คือหมา

ยเลขเสียงที่บันทึกที่ถูกสรางขึ้นโดยอัตโนมัติ)

เคล็ดลับ

คณุสามารถค นหาเส ียงท ี ่บ นัท ึกใน ••  ภายในโฟลเดอร การบ นัท ึก

บันทึกเสียงพูด/เสียง

ตอไปนี้คือวิธีการบันทึกเสียงพูด/เสียงดวยไมโครโฟนที่อยในตัวเครื่อง 

(โปรดดูที่สวน ภาพรวม สำหรับตำแหนงของไมโครโฟนที่อยในตัวเครื่อง):

1	 จากเมน หูน าหลกั เล ือก 

แตะ •	  เพ ื ่อเร ิ ่มการบ นัท ึก

แตะ •	 ; /  เพ ื ่อสล บัระหว างการบ นัท ึกและหยดุช ั ่วคราว

แตะ •	 9 เพ ื ่อหยดุ

เสียงที่ตองการไดถูกบันทึกไวในเครื่องเลนโดยอัตโนมัติแลว »»

(รูปแบบไฟลชื่อ: REC YYYY-MM-DD XXX.MP3 ซึ่ง YYYY-

MM-DD คือป เดือนและวันที่บันทึก และ XXX คือหมายเลขเสี

ยงที่บันทึกที่ถูกสรางขึ้นโดยอัตโนมัติ)

เคล็ดลับ

คณุสามารถค นหาเส ียงท ี ่บ นัท ึกใน ••  ภายในโฟลเดอร การบ นัท ึก

ฟงเสียงที่บันทึก

1	 ในเมน หูน าหลกั แตะ  เพ ื ่อเข าส โหมดม มุมองโฟลเดอร 

2	 แตะเพ ื ่อเป ดโฟลเดอร การบ นัท ึก

3	 ใช น ิ ้ วเล ื ่อนข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการบ นัท ึก

4	 เม ื ่อพบรายการบ นัท ึกท ี ่ต องการ ให แตะเพ ื ่อเร ิ ่มเล น

แตะ •	 ; เพ ื ่อหยดุเล นช ั ่วคราว

แตะ •	 2 เพ ื ่อเร ิ ่มเล นใหม 

แตะ •	  เพ ื ่อเปล ี ่ยนไปยงัโหมดบ นัท ึก

แตะ •	  เพ ื ่อด ตู วัเล ือกการบ นัท ึกเพ ิ ่มเต ิม

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

การถายโอนเสียงที่บันทึกไปยังคอมพิวเตอร

ใชซอฟตแวร Philips Songbird เพื่อซิงคไฟลสื่อของคุณ

หรือคุณสามารถถายโอนเสียงที่บันทึกไดใน Windows Explorer : 

1	 เช ื ่อมต อ MUSE ก บัเคร ื ่องคอมพ ิวเตอร 

2	 ใน Windows Explorer เป ด MUSE

3	 เล ือกโฟลเดอร  Recordings (รายการบ นัท ึก) > Voice (เส ียง) 

หร ือ FM radio (ว ิทย ุ FM)*

4	 ค ดัลอกและวางส ิ ่งท ี ่บ นัท ึกลงในตำแหน งท ี ่ต องการในคอมพ ิวเตอ

ร 

หมายเหตุ

*คณุสมบ ตั ิการบ นัท ึกเส ียงจากว ิทย ุ FM ม ีอย ในบางร นเท าน ั ้ น ••
โปรดด ูเมน บูนหน าจอของ MUSE เพ ื ่อค นหาคณุสมบ ตั ิท ี ่คณุใช งานได 

การลบวิดีโอที่กำลังเลนการบันทึก

ตอไปนี้เปนวิธีการลบเสียงที่บันทึกที่กำลังเลน:

1	 ขณะกำลงัฟ งเส ียงท ี ่บ นัท ึก ให แตะ 

2	 แตะต วัเล ือกเพ ื ่อลบเส ียงท ี ่บ นัท ึก

3	 แตะเพ ื ่อย ืนย นัการลบ
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ลบรายการบันทึกหนึ่งรายการหรือมากกวา

ตอไปนี้เปนวิธีการลบเสียงที่บันทึกโดยใช Windows Explorer :

1	 เช ื ่อมต อ MUSE ก บัเคร ื ่องคอมพ ิวเตอร 

2	 ใน Windows Explorer ให ค นหาโฟลเดอร  Recordings 

(รายการบ นัท ึก) > Voice (เส ียง) หร ือ FM radio (ว ิทย ุ FM)*

3	 ลบเส ียงท ี ่บ นัท ึกโดยใช ว ิธ ีเด ียวก บัการลบไฟล บนคอมพ ิวเตอร 

หมายเหตุ

*คณุสมบ ตั ิการบ นัท ึกเส ียงจากว ิทย ุ FM ม ีอย ในบางร นเท าน ั ้ น ••
โปรดด ูเมน บูนหน าจอของ MUSE เพ ื ่อค นหาคณุสมบ ตั ิท ี ่คณุใช งานได 
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14	 การด SD

การเสียบการด SD

1	 เป ด MUSE 

2	 เป ดฝาป องก นัฝ ุ ่นช องเส ียบการ ด Micro SD

3	 เส ียบการ ด Micro SD โดยให หงายด านส มัผ สัข ึ ้ น:

ไอคอนการด Micro SD »»  ถูกเพิ่มไปยังเมนูหนาหลัก

หมายเหตุ

MUSE รองร บัการ ด Micro SD ได ส งูถ งึ 32GB••

อิมพอรตไฟลจากการด Micro SD

1	 เส ียบการ ด Micro SD

2	 ในเมน หูน าหลกั แตะ  เพ ื ่อเข าส โหมดการ ด Micro SD

3	 แตะ  เพ ื ่อด ตู วัเล ือกการ ด Micro SD

4	 แตะต วัเล ือกเพ ื ่ออ ิมพอร ตไฟล จากการ ด Micro SD 

ไปยงัไลบราร ี ่ของ MUSE

สามารถเขาใชงานไฟลที่อิมพอรตผานทางไลบรารี่ภายใน »»

MUSE (เชน: ในเมนูหนาหลัก แตะ  เพื่อเขาใชงานไฟลเพล

งที่อิมพอรต)

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

เขาใชไฟลบนการด Micro SD

1	 เส ียบการ ด Micro SD

2	 ในเมน หูน าหลกั แตะ  เพ ื ่อเข าส โหมดการ ด Micro SD

3	 ใช น ิ ้ วเล ื ่อนข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการโฟลเดอร 

หร ือไฟล 

4	 แตะเพ ื ่อเป ดโฟลเดอร หร ือไฟล 

แตะ •	  เพ ื ่อด ตู วัเล ือกการ ด Micro SD เพ ิ ่มเต ิม

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั
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15	 ตัวอานขอความ

อานไฟลขอความ

1	 ในเมน หูน าหลกั แตะ  เพ ื ่อเข าส โหมดต วัอ านข อความ

แสดงรายการไฟลขอความ»»

2	 เล ื ่อนน ิ ้ วข ึ ้ นหร ือลงบนรายการเพ ื ่อค นหาไฟล ข อความ 

จากน ั ้ นแตะเพ ื ่อเล ือก

3	 เล ื ่อนน ิ ้ วจากขวาไปซ ายหร ือจากซ ายไปขวาบนข อความเพ ื ่อขย ั

บไปหน าก อนหน าหร ือถ ดัไป

แตะ •	  เพ ื ่อด ตู วัเล ือกต วัอ านข อความ

แตะ •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั
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16	 ใช MUSE เพื่อพกพาไฟลขอมูล

ตอไปนี้เปนวิธีการใช MUSE เพื่อจัดเก็บและพกพาไฟล:

1	 เช ื ่อมต อ MUSE ไปยงัคอมพ ิวเตอร  (โปรดด คูำแนะนำในส วน 

 เช ื อ่มต อและชาร จ)

2	 บนคอมพ ิวเตอร ใน Windows Explorer,คดัลอกไฟล ข อมลูและว

างลงบน MUSE

เคล็ดลับ

ใช คอมพ ิวเตอร ในการถ ายโอนข อม ลูของคณุกล บัไปยงัคอมพ ิวเตอร  ••
หร ือลบไฟล ข อม ลูของคณุออกจาก MUSE
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17	 การตั้งคา

วิธีการกำหนด MUSE:

1	 ในเมน หูน าหลกั แตะ  เพ ื ่อเข าส โหมดการต ั ้ งค า

2	 ในเมน กูารต ั ้ งค า

เล ื ่อนน ิ ้ วข ึ ้ นหร ือลงบนหน าจอเพ ื ่อเล ื ่อนด รูายการ•	
ต วัเล ือก

แตะเพ ื ่อเล ือกต วัเล ือก•	
แตะ •	  เพ ื ่อย ืนย นัต วัเล ือก (จำเป นสำหร บัการต ั ้ งค าบ

างรายการ)

แตะ •	  เพ ื ่อย อนกล บัไปยงัระด บัก อนหน า 

กด •	  เพ ื ่อย อนกล บัไปยงัเมน หูน าหลกั

ในเมนูการตั้งคา มีตัวเลือกดังตอไปนี้

การต ั ้ งค า เมนตูวัเล ือก เมนตูวัเล ือกย อย
การต ั ้ งค าประหย ดัพลงังาน* อนรุ กัษ ส ิ ่งแวดล อม!

เล ือกเวลาพ กัท ี ่ส ั ้ นท ี ่ส ดุ

จนกว าเคร ื ่องจะป ดอ ตัโนม ตั ิ

10 นาท ี (ค าเร ิ ่มต น)•	
20 นาท ี•	
30 นาท ี•	
เป ดตลอด•	

ต วัต ั ้ งเวลาป ดเคร ื ่อง ป ด (ค าเร ิ ่มต น)•	
15 นาท ี•	
30 นาท ี•	
60 นาท ี•	

การต ั ้ งค าหน าจอ ความสว าง {ต วัปร บัแถบสไลด }•	
ต วัต ั ้ งเวลาป ดหน าจอ 30 ว ินาท ี•	

1 นาท ี (ค าเร ิ ่มต น)•	
2 นาท ี•	
5 นาท ี•	
เป ดตลอด•	

พ ื ้ นหลงั ธ ีม 1 (ค าเร ิ ่มต น)•	
ธ ีม 2•	
ธ ีม 3•	
ต ั ้ งเอง (จากไลบราร ี ่ภาพ)•	

ว นัท ี ่และเวลา ต ั ้ งค าว นัท ี ่
ต ั ้ งร ปูแบบว นัท ี ่ วว ดด ปปปป (ค าเร ิ ่มต น)•	

ดด วว ปปปป•	
ปปปป ดด วว•	

ต ั ้ งค าเวลา
ต ั ้ งร ปูแบบเวลา 12 ช ั ่วโมง•	

24 ช ั ่วโมง (ค าเร ิ ่มต น)•	
แสดงเวลาบนส วนห วั เป ด (ค าเร ิ ่มต น)•	

ป ด•	
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การต ั ้ งค า เมนตูวัเล ือก เมนตูวัเล ือกย อย
ภาษา เชค•	

กร ีก•	
องักฤษ (ค าเร ิ ่มต น)•	
เดน ิช•	
เยอรม นั•	
สเปน•	
ฝร ั ่งเศส•	
อ ิตาล ี•	
ฮงัการ ี•	

ดตัช •	
นอร เวย •	
โปล ิช•	
โปรต เุกส •	
โปรต เุกส (บราซ ิล)•	
ร สัเซ ีย•	
สโลว กั•	
ฟ นด แลนด •	
สว ีเดน•	

ตรุก ี•	
จ ีน (แผ นด ินใหญ)•	
จ ีน (ไต หว นั)•	
ญ ี ่ป ุ ่น•	
เกาหล ี•	
ไทย•	
ฮ ีบร ู (ม ีอย ในบางร นเท าน ั ้ น)•	
อาระบ ิก (ม ีอย ในบางร นเท าน ั ้ น)•	

การต ั ้ งค าการเช ื ่อมต อ PC MSC - จ ดัเก บ็ข อม ลู (ค าเร ิ ่มต น)•	
MTP - ถ ายโอนส ื ่อ•	

ข อม ลูของคณุ ความจ :ุ

พ ื ้ นท ี ่ว าง:

เวอร ช นัเฟ ร มแวร :

ร น:

CTN:

เว บ็ไซต สน บัสนนุ:
ฟอร แมตอปุกรณ ข อม ลูท ั ้ งหมดจะถ กูลบ 

ดำเน ินการต อหร ือไม 

ใช •	
ไม ใช •	

ร ีเซ ต็การต ั ้ งค า เร ียกค ืนค าจากโรงงาน

ไฟล ท ี ่ถ ายโอนไปยงัเคร ื ่องเล นจะไม ไ

ด ร บัผลกระทบ

เร ียกค ืน•	
ยกเล ิก•	

* คาเริ่มตนตั้งไวที่ 10 นาทีเปนโหมดประหยัดพลังงานสูงที่สุด ใหคงการตั้งคาอุป

กรณในโหมดนี้เพื่อชวยอนุรักษสิ่งแวดลอมผานการสงวนพลังงานแบตเตอรี่
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18	 ขอมูลทางเทคนิค

เป ด/ป ด

แหล งจ ายไฟ: แบตเตอร ี ่ภายใน 1,100 mAh Li-ion Polymer 

แบบชาร จได 

เวลาเล น¹ 

- เส ียง: 24 ช ั ่วโมง

- ว ิด โีอ: 5 ช ั ่วโมง
ซอฟต แวร 

Philips Songbird: ใช ในการอ พัเดตเฟ ร มแวร และถ ายโอนเพลง
การเช ื อ่มต อ

หฟู ง 3.5 มม. 

USB 2.0 ความเร ว็ส งู

HDMI
เส ียง

การแยกช อง: 50 dB

การตอบสนองต อความถ ี :่ 20 - 18,000 Hz

พลงัข บัเส ียง: 2 x 2.7 mW (สำหร บัเวอร ช นั EU); 

2 x 10.5 mW (สำหร บัเวอร ช นั Non-EU)

อ ตัราส วนสญัญาณต อการรบกวน: > 85 dB

การเล นเส ียง
ร ปูแบบท ี ่รองร บั:
อ ตัราบ ิต อ ตัราการส มต วัอย าง
MP3:
8 - 320 kbps และ VBR 8, 11.025, 16, 22.050, 32, 44.1, 48 kHz
WMA:
5 - 320 kbps 8, 11.025, 16, 22.050, 32, 44.1, 48 kHz
FLAC:
ส งูถ งึ 1.5 Mbps 48 kHz
APE:
ส งูถ งึ 1.5 Mbps 48 kHz
OGG:
ส งูถ งึ 320 kbps 8 - 48 kHz
AAC:
ส งูถ งึ 320 kbps 8 - 48 kHz

การเล นว ิด โีอ

ร ปูแบบท ี ่รองร บั:

MPEG4 (ในร ปูแบบ .avi และ .mp4)

RMVB

WMV
การแสดงภาพ

ร ปูแบบท ี ่รองร บั:

JPEG

BMP

PNG

GIF

ส ื อ่จดัเก บ็ข อมลู

ความจหุน วยความจำภายใน²:

SA2MUS04 4GB NAND Flash

SA2MUS08 8GB NAND Flash

SA2MUS16 16GB NAND Flash

SA2MUS32 32GB NAND Flash
การแสดงผล

หน าจอ LCD ส ไีวต อการส มัผ สั 480 x 320 พ ิกเซล (HVGA)

หมายเหตุ

¹ แบตเตอร ี ่แบบชาร จได ม ีจำนวนรอบของการชาร จท ี ่จำก ดั อายกุารใช งานขอ••
งแบตเตอร ี ่และจำนวนรอบของการชาร จไฟใหม จะแตกต างก นัไปตามการใช งา
นและการต ั ้ งค า 
² 1GB = 1 พ นัล านไบต ; พ ื ้ นท ี ่จ ดัเก บ็จะน อยกว า ความจหุน วยความจำอาจไม••
สามารถใช งานได ท ั ้ งหมดเน ื ่องจากม ีการสงวนหน วยความจำบางส วนไว สำหร บั
ระบบเคร ื ่องเล น ความจขุองการจ ดัเก บ็คำนวณโดยอ างอ งิจากเพลงท ี ่ม ีความยาว 
4 นาท ีและใช การเข ารห สัแบบ MP3 128 kbps

ความตองการของระบบ

Windows® XP (SP3 หร ือส งูกว า) / Vista / 7•	
Pentium III 800 MHz processor หร ือส งูกว า•	
512 MB RAM•	
พ ื ้ นท ี ่บนฮาร ดด ิสก  500 MB•	
การเช ื ่อมต ออ ินเตอร เน ต็•	
Windows® Internet Explorer 6.0 หร ือใหม กว า•	
ไดรฟ  CD-ROM•	
พอร ต USB•	
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19	 ประมวลศัพท

F

FLAC [Free Lossless Audio Codec]

ร ปูแบบไฟล เส ียงท ี ่คล ายก บั MP3 แต ไม ม ีการส ญูเส ีย ซ ึ ่งหมายความว าเ

ส ียงจะถ กูบ ีบอ ดัในร ปูแบบ FLAC โดยไม ส ญูเส ียคณุภาพ 

FM (สญัญาณคล ื ่นว ิทย )ุ

ในการกระจายเส ียงว ิทย :ุ ว ิธ ีการในการปร บัสญัญาณคล ื ่นความถ ี ่น ั ้ นแต

กต างก นัข ึ ้ นอย ก บัความแรงของสญัญาณคล ื ่นว ิทย ุ

FullSound

FullSound™ เป นเทคโนโลย ีสม ยัใหม ท ี ่ออกแบบโดย Philips FullSound™ 

จะค ืนความละเอ ียดของสญัญาณเส ียงของดนตร ีท ี ่ถ กูบ ีบอ ดั และปร บั 

แต งเพ ื ่อให เส ียงท ี ่ทรงพลงัโดยไม ผ ิดเพ ี ้ ยน 

L

LCD (Liquid Crystal Display)

อาจเร ียกได ว าเป นว ิธ ีท ี ใ่ช ก นัโดยท ั ่วไปในการแสดงข อม ลูภาพบนอปุกร

ณอ ิเล ก็ทรอน ิกส ท ี ไ่ม ใช คอมพ ิวเตอร 

M

MP3

ร ปูแบบของไฟล ท ี ่ม ีระบบบ ีบอ ดัข อม ลูเส ียง MP3 ย อมาจาก 

Motion Picture Experts Group 1 (หร ือ MPEG-1) Audio Layer 3 

ด วยข อม ลูร ปูแบบ MP3 ทำให  CD-R หร ือ CD-RW หน ึ ่งแผ นสามารถบ

รรจขุ อม ลูมากกว าซ ีด ีท ั ่วไปถ งึ 10 เท า 

MSC [Mass Storage Class]

ระด บัของอปุกรณเก บ็ข อม ลูแบบ USB (หร ือ USB MSC หร ือ UMS) ค ื

อชดุของการโปรโตคอลการส ื ่อสารท ี ่ม ีอ ินเตอร เฟซให ก บัอปุกรณการจ ั

ดเก บ็ อปุกรณท ี ่รองร บัมาตรฐานน ี ้ ม กัร จ กัในช ื ่อ อปุกรณ MSC (Mass 

Storage Class)

MTP [Media Transfer Protocol]

Media Transfer Protocol รองร บัการถ ายโอนไฟล เพลงและว ิด โีอไปยงัเค

ร ื ่องเล นเพลงและเคร ื ่องเล นว ิด โีอแบบพกพา

N

Napster

Napster ค ือบร ิการเพลงออนไลน ท ี ไ่ม จำก ดัเพลงท ี ่คณุสามารถถ ายโอนไ

ปยงัเคร ื ่องเล น MUSE ของคณุ 

O

Ogg Vorbis

Album art ค ือคณุสมบ ตั ิท ี ใ่ช แสดงอาร ตเว ิร ก (ภาพปก) 

ของอ ลับ ั ้ มเพลง การแสดงผลน ี ้ ทำให ผ ใช เล ือกระบอุ ลับ ั ้ มเพลง 

ได อย างรวดเร ว็ คณุสามารถดาวน โหลดไฟล อาร ตเว ิร กสำหร บัอ ลับ ั ้ มเพ

ลงได จากอ ินเทอร เน ต็

R

RDS (Radio Data System)

จ นูเนอร  RDS สามารถหาคล ื ่นสถาน ีตามประเภทของเพลง 

(หร ือการพ ดูค ยุ) ท ี ่กระจายเส ียงได โดยอ ตัโนม ตั ิ RDS สามารถเป ดใ

ช งานต วัร บัสญัญาณเพ ื ่อแสดงข อความต วัอ กัษรและกราฟ กได อ ีกด 

วย (ปกต ิเร ียกว าต วัอ กัษรและร ปูแบบข อม ลู) ท ี ่หลายๆ สถาน ี FM ไ

ด รวมไว ในสญัญาณคล ื ่นพาหะย อยภายในสญัญาณกระจายเส ียงปกต ิ 

จ นูเนอร บางชน ิดม ี RDS สามารถร บัได แม กระท ั ่งการแจ งเต ือนจราจ

รหร ือ การกระจายเส ียงฉกุเฉ ินได ในขณะกำลงัเล นส ื ่ออ ื ่น - CD MD 

หร ือคาสเซ ต็ต  ม ีคณุสมบ ตั ิอ ื ่นท ี ่เป นประโยชน ซ ึ ่งม ีให ตามการเพ ิ ่มจ

ำนวนสถาน ี RDS

S

SuperScroll

SuperScroll™ ค ือคณุสมบ ตั ิการเล ือกหาไฟล ท ี ่คณุต องการด วยป ุ ่มค น

หาแบบ Double-action ของผล ิตภณัฑ  SuperScroll™ ช วยให การควบ

ค มุเม ื ่อเล ื ่อนหาไฟล ในไลบราร ีขนาดใหญม ีความสะดวกและรวดเร ว็ย ิ ่

งข ึ ้ น และช วยให สามารถหาไฟล ในไลบราร ีขนาดใหญได เร ว็ข ึ ้ นด วย 

เม ื ่อกดป ุ ่มค างไว นานข ึ ้ น ความเร ว็ในการเล ื ่อนก จ็ะเพ ิ ่มข ึ ้ นด วย

ก

การบ ีบอดั

ในคำน ิยามด านระบบเส ียง การบ ีบอ ดัค ือกระบวนการลดข อม ลูเส ียงช ั ่ว

คราวหร ือถาวรเพ ื ่อการจ ดัเก บ็หร ือการส งสญัญาณได อย างม ีประส ิทธ ภิา

พมากข ึ ้ น การลดขนาดไฟล ช ั ่วคราวเร ียกว า การบ ีบอ ดัแบบ ‘non-lossy’ 

และไม ม ีข อม ลูส ญูหายไป การลดขนาดไฟล อย างถาวร (เช น สำหร บัไฟล  

MP3) เร ียกว า การบ ีบอ ดัแบบ ‘lossy’ และม ีการลบข อม ลูท ี ไ่ม จำเป นออก

ไปซ ึ ่งไม สามารถเร ียกกล บัค ืนมาได 

การบ ีบอดัแบบไม สญูเส ีย

ระบบหน ึ ่งของการลดจำนวนบ ิตของข อม ลู (ความหนาแน น) ในสญัญาณเ

ส ียงทางดนตร โีดยไม เก ิดข อผ ิดพลาดต อต นฉบ บั

การตอบสนองต อความถ ี ่

ค ือช วงความถ ี ่ท ี ่ลำโพงสร างข ึ ้ น ม ีต ั ้ งแต ความถ ี ่ต สดุถ งึส งูสดุ 

ขณะท ี ่ค าปกต ิม ีค าเท าก บั 20-20,000 Hz (Hertz) ช วงการได ย ินของแต 
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ละคนน ั ้ นจะม ีข ีดจำก ดัมากกว า ระบบลำโพงแบบเต ม็ช วงท ี ่ด ีน ั ้ นจะส

ร างช วงความถ ี ไ่ด มากเพ ื ่อให ครอบคล มุถ งึความแตกต างก นัท ั ้ งหมด ผ ข บั

ข ี ่รถแต ละคนจะม ีข อจำก ดัอย ในส วนสเปกตร มัท ี ไ่ด ถ กูสร างข ึ ้ นโดยเฉพา

ะ ดงัน ั ้ นการตอบสนองของพวกเขาจ งึอย ในวงจำก ดั แต ย งัเป นประเด น็สำค ั

ญท ี ่ควรพ ิจารณาเม ื ่อออกแบบระบบเส ียงท ี ่สมบ รูณแบบ

ร

ร ิป (การร ิป)

ใช โปรแกรมซอฟต แวร ท ี ่ “บ นัท ึก” เส ียงด ิจ ิตอลจากคอมแพคด ิสก แล

ะถ ายโอนไปยงัฮาร ดไดรฟ คอมพ ิวเตอร  ข อม ลูจะได ร บัการเก บ็ร กัษา

อย างด ี เน ื ่องจากสญัญาณไม ส งผ านการ ดเส ียงของคอมพ ิวเตอร  และ

ไม จำเป นต องแปลงเป นร ปูแบบอะนาล อ็ก การถ ายโอนระบบด ิจ ิตอล-

ด ิจ ิตอลจะสร างไฟล  WAV ท ี ่สามารถแปลงเป นไฟล  MP3 ได 

อ

อตัราบ ิต

อตัราบ ิตค ือจำนวนบ ิตซ ึ ่งได ร บัการประมวลผลต อช วงระยะเวลาหน ึ ่ง อ ั

ตราบ ิตปกต ิจะได ร บัการว ดัเป นจำนวนบ ิตต อว ินาท ี (ก โิลบ ิตต อว ินาท ี: 

kbps) คำว าอ ตัราบ ิตม ีความหมายเด ียวก บัอ ตัราการถ ายโอนข อม ลู 

(หร ืออ ตัราข อม ลูธรรมดา) 

เ

เดซ ิเบล (dB)

หน วยท ี ใ่ช ว ดัระด บัพลงัหร ือความเข มเส ียง

เส ียงเซอร ราวด สำหร บัภาพยนตร 

เส ียงเซอร ราวด รวบรวมเทคน ิคต างๆ เข าไว ด วยก นัเพ ื ่อเพ ิ ่มคณุภาพการ

สร างสำเนาเส ียงจากแหล งเส ียง ขอบเขตการได ย ินแบบสามม ิต ิ (3D) ของ

มนษุย สามารถร บัฟ งได จร งิผ านเส ียงเซอร ราวด  
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